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. __________________________________________________________________________________________________________________________________________|
Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the
Safety Information in "About This Machine" before using the machine.



Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your safety and
benefit, read this manual carefully before using the machine. Keep this manual in a handy place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be liable for
direct, indirect, special, incidental, or consequential damages as a result of handling or operating the machine.

Software Version Conventions Used in This Manual

¢ NetWare 3.x means NetWare 3.12 and 3.2.
¢ NetWare 4.x means NetWare 4.1, 4.11, 4.2 and IntranetWare.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Apple, AppleTalk, EtherTalk, Macintosh, Mac OS , and TrueType are trademarks of Apple Computer,
Inc, registered in the United States and other countries.

Bonjour™ is a trademark of Apple Computer Inc.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corporation.
Novell, NetWare, NDS and NDPS are registered trademarks of Novell, Inc.

PostScript® and Acrobat® are registered trademarks of Adobe Systems, Incorporated.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

Citrix® and MetaFrame® are registered trademarks of Citrix Systems, Inc.
UPNP is a trademark of the UPnP Implementers Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:
» The product name of Windows® 95 is Microsoft® Windows 95.
» The product name of Windows® 98 is Microsoft® Windows 98.
e The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).
» The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server

» The product names of Windows® XP are as follows:
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Professional

» The product names of Windows Server® 2003 are as follows:
Microsoft® Windows Server® 2003 Standard Edition
Microsoft® Windows Server® 2003 Enterprise Edition
Microsoft® Windows Server® 2003 Web Edition

* The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0

* RSA Data Security, Inc. MD5 Message-Digest Algorithm
Copyright® 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.
License to copy and use this software is granted provided that it is identified as the “RSA Data Security,
Inc. MD5 Message-Digest Algorithm” in all material mentioning or referencing this software or this function.
License is also granted to make and use derivative works provided that such works are identified
as “derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all material men-
tioning or referencing the derived work.
RSA Data Security, Inc. makes no representations concerning either the merchantability of this soft-
ware or the suitability of this software for any particular purpose. It is provided “as is” without ex-
press or implied warranty of any kind.
These notices must be retained in any copies of any part of this documentation and/or software.



Manuails for This Machine

Refer to the manuals that are relevant to what you want to do with the machine.

iﬁklmportant
O Media differ according to manual.

O The printed and electronic versions of a manual have the same contents.

O Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.

O Depending on which country you are in, there may also be html manuals. To
view these manuals, a Web browser must be installed.

O For details about the functions of RW-3600, refer to the manuals for this option.

+» About This Machine
Be sure to read the Safety Information in this manual before using the machine.
This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMs provided.

% General Settings Guide
Explains User Tools settings, and Address Book procedures such as registering
fax numbers, e-mail addresses, and user codes. Also refer to this manual for
explanations on how to connect the machine.

« Trouble Shooting
Provides a guide to solving common problems, and explains how to replace
paper, toner, and other consumables.

R
**

Security Reference

This manual is for administrators of the machine. It explains security functions
that the administrators can use to protect data from being tampered, or prevent
the machine from unauthorized use.

Also refer to this manual for the procedures for registering administrators, as
well as setting user and administrator authentication.

< Copy/Document Server Reference
Explains Copier and Document Server functions and operations. Also refer to
this manual for explanations on how to place originals.

% Printer Reference
Explains Printer functions and operations.

< Scanner Reference
Explains Scanner functions and operations.

% Network Guide
Explains how to configure and operate the machine in a network environment,
and use the software provided.



« Other manuals

e Manuals for This Machine

¢ Safety Information

* Quick Reference Copy Guide

® Quick Reference Printer Guide

¢ Quick Reference Scanner Guide

¢ PostScript3 Supplement

¢ UNIX Supplement

* Manuals for DeskTopBinder Lite
* DeskTopBinder Lite Setup Guide
¢ DeskTopBinder Introduction Guide
e Auto Document Link Guide

& Note
O Manuals provided are specific to machine types.

O For “UNIX Supplement”, please visit our Web site or consult an authorized
dealer.

O “PostScript3 Supplement” and “UNIX Supplement” include descriptions of
functions and settings that might not be available on this machine.
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How to Read This Manual

Symbols

This manual uses the following symbols:

/\ WARNING:
Indicates important safety notes.
Ignoring these notes could result in serious injury or death. Be sure to read these

notes. They can be found in the “Safety Information” section of About This Ma-
chine.

/\ CAUTION:
Indicates important safety notes.
Ignoring these notes could result in moderate or minor injury, or damage to the

machine or to property. Be sure to read these notes. They can be found in the
“Safety Information” section of About This Machine.

*gklmportant

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

& Note

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

A Reference

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.

[]

Indicates the names of keys that appear on the machine’s display panel.

[]

Indicates the names of keys on the machine’s control panel.



Setting Up the Machine on a Network

This section describes the network settings you can change with User Tools (Sys-
tem Settings). Make settings according to functions you want to use and the in-
terface to be connected.

ﬂlmportant
O These settings should be made by the systems administrator, or after consult-

ing with the systems administrator.

Initial Settings Overview

+ Interface Settings

Menu Description

Machine IPv4 Address Specifies the machine IPv4 address and sub-
net mask in the network environment.

IPv4 Gateway Address Configure the gateway address for the router
or host computer used as a gateway.

Machine IPv6 Address Specifies the machine IPv6 address and sub-
net mask in the network environment.

IPv6 Gateway Address Configure the gateway address for the router
or host computer used as a gateway.

IPv6 Stateless Address Autoconfiguration | Specifies the automatic configuration of the

IPv6 Stateless Address.
DNS Configuration Make settings for the DNS server.
DDNS Configuration Specifies the DDNS settings.
Domain Name Specifies the domain name.
WINS Configuration Specifies the WINS server settings.
Effective Protocol Select the protocol to use in the network.
NCP Delivery Protocol Select the protocol for NCP delivery:
NW Frame Type Select the frame type when you use Net-
Ware.
LAN Type Select interface, IEEE 802.11b (wireless LAN)

or Ethernet when you have installed the op-
tional IEEE 802.11b interface unit.

Ethernet Speed Set the access speed for networks.

Ping Command Check the network connection with ping
command using given IP address.

SMB Computer Name Specifies the SMB computer name.

SMB Work Group Specifies the SMB work group.

Permit SNMPv3 Communication Set the encrypted communication of SNMP

v3.
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Menu

Description

Permit SSL / TLS Communication

Set the encrypted communication of
SSL/TLS.

Host Name

Specify the host name.

Machine Name

Specify the machine name.

Communication Mode

Specifies the communication mode of the
wireless LAN.

SSID Setting Specifies SSID to distinguish the access point
in infrastructure mode or 802.11 ad hoc
mode.

Channel Specifies a channel when you select 802.11b
ad hoc mode or ad hoc mode.

WEP (Encryption) Key Specifies the encryption of the IEEE 802.11b

(wireless LAN).

Transmission Speed

Specifies the communication speed of the
IEEE 802.11b (wireless LAN).

Restore Factory Defaults

Return the IEEE 802.11b (wireless LAN) set-
tings to their defaults.

File Transfer Settings

Menu Description
SMTP Server Specifies the SMTP server name.
SMTP Authentication Configures SMTP authentication (PLAIN,
LOGIN, CRAM-MD5, DIGEST-MD5
POP before SMTP Configures POP authentication (POP before

SMTP).

Administrator's E-mail Address

This appears as the sender’s address on e-
mailed scanned documents, if the sender is
not specified .

Program / Change / Delete E-mail Message

Specify the user name and password re-
quired when sending scan file directly to a
shared folder on a computer running Win-
dows, or to an FTP server.

Default User Name / Password (Send)

Specifies the user name and password re-
quired when sending scan file directly to a
shared folder on a computer running Win-
dows, or to an FTP server.

Program / Change / Delete Subject

Program, change, or delete the subject used
when sending a scan file as an attachment.

Scanner Resend Interval Time

Specifies the interval the machine waits be-
fore resending scan file, if they cannot be
sent to the delivery server or mail server.

Number of Scanner Resends

Sets a maximum number of times scan file is
resent to the delivery server or mail server




Initial Settings

% Printer

Interface

Settings

Ethernet

Interface Settings/Net-
work

Machine IPv4 Address

IPv4 Address

IPv4 Gateway Address

Machine IPv6 Address

IPv6 Gateway Address

IPv6 Stateless Address Autoconfig-
uration

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

NW Frame Type

LAN Type

Ethernet Speed

SMB Computer Name

SMB Work Group

Permit SNMPv3 Communication

Permit SSL / TLS Communication

Host Name

Machine Name




Interface

Settings

IEEE 802.11b (wireless
LAN)

Interface Settings/Net-
work

Machine IPv4 Address

IPv4 Address

IPv4 Gateway Address

Machine IPv6 Address

IPv6 Gateway Address

IPv6 Stateless Address Autoconfig-
uration

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

NW Frame Type

LAN Type

Ethernet Speed

Effective Protocol

NCP Delivery Protocol

SMB Computer Name

SMB Work Group

Permit SNMPv3 Communication

Permit SSL / TLS Communication

Host Name

Machine Name

Interface Settings/IEEE
802.11b

Communication Mode

SSID Setting

Channel

WEP (Encryption) Key

Security Method

Wireless LAN Signal

Transmission Speed




« E-Mail (IPv6 cannot be used on this function.)

Interface

Settings

Ethernet

Interface Settings/Net-
work

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

LAN Type

Ethernet Speed

Effective Protocol

NCP Delivery Protocol

Permit SNMPv3 Communication

Permit SSL / TLS Communication

Host Name

File Transfer

SMTP Server

SMTP Authentication

POP before SMTP

AAdministrator's E-mail Address

Program / Change / Delete E-mail
Message

Program / Change / Delete Subject

Scanner Resend Interval Time

Number of Scanner Resends




Interface

Settings

IEEE 802.11b (wireless

LAN)

Interface Settings/Net-
work

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

LAN Type

Ethernet Speed

Effective Protocol

NCP Delivery Protocol

Permit SNMPv3 Communication

Permit SSL / TLS Communication

Host Name

Interface Settings /IEEE
802.11b

Communication Mode

SSID Setting

Channel

WEP (Encryption) Key

Transmission Speed

File Transfer

SMTP Server

SMTP Authentication

POP before SMTP

Administrator's E-mail Address

Program / Change / Delete E-mail
Message

Program / Change / Delete Subject

Scanner Resend Interval Time

Number of Scanner Resends




«+ Scan to Folder (IPv6 cannot be used on this function.)

Interface

Settings

Ethernet

Interface Settings/Net-
work

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

LAN Type

Ethernet Speed

Effective Protocol

NCP Delivery Protocol

Host Name

Permit SNMPv3 Communication

Permit SSL / TLS Communication

File Transfer

Default User Name / Password
(Send)

Scanner Resend Interval Time

Number of Scanner Resends




Interface

Settings

IEEE 802.11b (wireless

LAN)

Interface Settings/Net-
work

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

LAN Type

Ethernet Speed

Effective Protocol

Permit SNMPv3 Communication

Permit SSL / TLS Communication

Host Name

Interface Settings/IEEE
802.11b

Communication Mode

SSID Setting

Channel

WEP (Encryption) Key

Transmission Speed

File Transfer

Default User Name / Password
(Send)

Scanner Resend Interval Time

Number of Scanner Resends
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« Network Delivery Scanner (IPv6 cannot be used on this function.)

Interface

Settings

Ethernet

Interface Settings/Net-
work

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

LAN Type

Ethernet Speed

Effective Protocol

NCP Delivery Protocol

Permit SNMPv3 Communication

Permit SSL / TLS Communication

Host Name

File Transfer

Delivery Option

Scanner Resend Interval Time

Number of Scanner Resends




Interface

Settings

IEEE 802.11b (wireless

LAN)

Interface Settings/Net-
work

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

LAN Type

Ethernet Speed

Effective Protocol

NCP Delivery Protocol

Permit SNMPv3 Communication

Permit SSL / TLS Communication

Host Name

Interface Settings /IEEE
802.11b

Communication Mode

SSID Setting

Channel

WEP (Encryption) Key

Transmission Speed

File Transfer

Delivery Option

Scanner Resend Interval Time

Number of Scanner Resends

11
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< Network TWAIN Scanner (IPv6 cannot be used on this function.)

Interface

Settings

Ethernet

Interface Settings/Net-
work

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

LAN Type

Ethernet Speed

Effective Protocol

NCP Delivery Protocol

Permit SNMPv3 Communication

Permit SSL / TLS Communication

Host Name

IEEE 802.11b (wireless
LAN)

Interface Settings /Net-
work

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

LAN Type

Ethernet Speed

Effective Protocol

NCP Delivery Protocol

Permit SNMPv3 Communication

Permit SSL / TLS Communication

Host Name

Interface Settings /IEEE
802.11b

Communication Mode

SSID Setting

Channel

WEP (Encryption) Key

Transmission Speed




< Document Server (IPv6 cannot be used on this function.)

Interface

Settings

Ethernet

Interface Settings/Net-
work

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

LAN Type

Ethernet Speed

Effective Protocol

NCP Delivery Protocol

Permit SNMPv3 Communication

Permit SSL / TLS Communication

Host Name

IEEE 802.11b (wireless
LAN)

Interface Settings /Net-
work

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

LAN Type

Ethernet Speed

Effective Protocol

NCP Delivery Protocol

Permit SNMPv3 Communication

Permit SSL / TLS Communication

Host Name

Interface Settings /IEEE
802.11b

Communication Mode

SSID Setting

Channel

WEP (Encryption) Key

Transmission Speed

13
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& Note

O Depending on which optional units you have installed or the printer lan-
guage you have selected, some options are not displayed.

O Depending on the security settings, you might not be able to set certain options.
A Reference
For details, see “System Settings”, General Settings Guide.

For details about copier features and system settings, see Copy Reference and
General Settings Guide.



e
1. Using a Printer Server

Preparing Printer Server

This section explains how to configure the machine as a Windows network
printer. The machine is configured to enabling network clients to use it. When
the network printer is connected via SmartDeviceMonitor for Client, you can set
the printing notification function to notify clients of the results of their print jobs.

iiklmportant

O Under Windows 2000, Windows XP Professional, or Windows Server 2003, to
change printer properties in the [Printer] folder, you need Printer Management
access authentication; under Windows NT 4.0, Full Control access authentica-
tion. Log on to the file server as an Administrator or member of the PowerUsers

group.
ﬂ Open the [Printers] window from the [Start] menu.

The [Printers] window appears.

Under Windows XP or Windows Server 2003, [Printer and Fax] window appears.

ﬂ Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

E] On the [Sharing] tab, click [Shared As: ].

ﬂ To share the machine with users using a different version of Windows,
click [Additional Drivers...].

If you have installed an alternative driver by selecting [Share As: ] during the
printer driver installation, this step can be ignored.

B Click [OK], and then close the printer properties.

15
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Using a Printer Server

Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the machine to use the printing notification
function of SmartDeviceMonitor for Client.

Setting the print server

ﬂlmportant

O Under Windows 2000, Windows XP Professional, or Windows Server 2003, to
change printer properties in the [Printer] folder, you need Printer Management
access authentication; under Windows NT 4.0, Full Control access authentica-
tion. Log on to the file server as an Administrator or member of the PowerUsers

group.
ﬂ On the [Start] menu, point to [Programs], [DeskTopBinder], [SmartDeviceMonitor

for Client], and then click [Print Server Setting].
The print server setting dialog box appears.

ﬂ Select the [Notify client PCs of printout/data-transmission ] check box, and then
click [OK].
After print server setting is made, a dialog box appears. Confirm the dialog
box content, and click [OK].
Click [Cancel] to interrupt the procedure.
A dialog box appears for client setting.

B click [ok).
The print server setting is completed. Each client must be set to receive print
notification.

& Note

O Current printing jobs restart from the beginning after the spooler pauses
briefly.

O When the expansion function is not used, the function is automatically set
as available.

O If youlog on using an account that does not have Administrator privileges,
the client may not be notified.

Setting a Client

ﬂ On the [Start] menu, point to [Program], [DeskTopBinder], [SmartDeviceMonitor
for Client], and then click [Extended Features Settings].

A dialog box for setting the expansion function appears.
EI Select the [Notify of printout/data-transmission when using print server] check box.
B crick [ok).

The client setting is completed.

& Note

O Set the printing notification function on the printer driver as well as on
SmartDeviceMonitor for Client.



Using NetWare

Using NetWare

This section describes the setting procedure for network printers in the NetWare
environment. In the NetWare environment, you can connect the machine as a
“print server” or “remote printer”.

iiklmportant
O IPv6 cannot be used on this function.

« Setting procedure
When using the machine as a print server
@ Installing SmartDeviceMonitor for Admin
® Setting the network interface board.
® Turning the machine off and then back on.
When using the machine as a remote printer
@ Installing SmartDeviceMonitor for Admin.
@ Setting the network interface board.
® Setting NetWare.
@ Starting the print server.

& Note

O This procedure assumes an environment is already prepared for normal Net-
Ware running the printing service setting.

O The procedure is explained with the following example settings:
e File server’s name ...CAREE
¢ Print server’s name ...PSERV
¢ Printer’s name ...R-PRN
¢ Queue name ...R-QUEUE

% Using SmartDeviceMonitor for Admin

To use the machine in a NetWare environment, use SmartDeviceMonitor for
Admin to set the NetWare printing environment.

« Printers listed by SmartDeviceMonitor for Admin
SmartDeviceMonitor for Admin lists printers connected to the network. If
you cannot identify the machine you want to configure, print configuration
page, and then check the machine name.

4 Note

O The NetWare Client provided by Novell is required to set the printing envi-
ronment using SmartDeviceMonitor for Admin under the following environ-
ments:

e NDS mode in Windows 95/98/Me
* NDS or Bindery mode in Windows 2000/XP, Windows NT 4.0

A Reference
p-40 “Installing SmartDeviceMonitor for Admin”
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Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the machine as a print server using Net-
Ware 3.x.

ﬂ Open a Web browser, and then enter "http://(printer's address)/" in the address
bar. Top Page of Web Image Monitor appears.

g Click [Login].
A dialog box for entering the login user name and password appears.

8 Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

ﬂ Click [Configuration] in the left area, and then click [NetWare].

Print Server Name: Enter the NetWare print server name. To use the interface
board as a print server, enter the name of a print server that is not active on the
file server. Use up to 47 characters.

Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

File Server Name: When a file server name is entered here, only the specified
file server is searched for. This item is mandatory. Use up to 47 characters.

NDS Tree: To enable NDS mode, enter the name of the NDS tree you want
to log on to. Use up to 32 alphanumeric characters.

NDS Context Name: To enable NDS mode, enter the print server context.
Use up to 127 characters.

Operation Mode: Specify whether to use the interface board as a print server
or a remote printer.

Remote Printer No.: This item is effective when the interface board is specified
as a remote printer. Enter the same number as the number of the printer to be
created on the print server (0 to 254 characters).

Job Timeout: When the interface board is used as a NetWare remote printer,
the printer cannot detect when a print job ends. Therefore, the printer termi-
nates printing when a certain period of time has elapsed since it last received
print data (i.e., when it has not received print data for a certain period of
time). Specify here this period of time (3 to 255 seconds). The initial value is
15 (seconds).

Frame Type: Select the frame type from the drop-down menu.

Print Server Protocol: Select the protocol for NetWare from the drop-down
menu.

NCP Delivery Protocol: Select the protocol for NCP delivery.



Using NetWare

B Confirm the settings, and then click [OK].
Configuration is now complete. Wait several before restarting Web Image
Monitor.

(3 click [Logout].

& Note

O To check the configuration is correct, enter the following from the command
prompt:
F:> USERLIST

O If the printer works as configured, the name of the print server appears as
a connected user.

O If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see Printer Reference.

O If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

O For details about the login user name and password, see Security Reference.

19



20

Using a Printer Server

Setting Up as a Print Server (NetWare 4.x,5/5.1,6/6.5)

Follow the procedure below to connect the machine as a print server using Net-
Ware 4.x, NetWare 5 / 5.1, or NetWare 6 / 6.5.

iﬁklmportant
O When using the printer as a print server in NetWare 4.x, NetWare 5 / 5.1, or

NetWare 6 / 6.5, set it to the NDS mode.
O When using NetWare 5 / 5.1 or NetWare 6 / 6.5, set the printer as a print server.

ﬂ Open a Web browser, and then enter "http://(printer's address)/" in the ad-
dress bar. Top Page of Web Image Monitor appears.

B click [Login].
A dialog box for entering the login user name and password appears.

B Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

ﬂ Click [Configuration] in the left area, and then click [NetWare].

B Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

(3 cick [Logout).

& Note

O To check the configuration is correct, enter the following from the command
prompt:
F:> USERLIST

O If the printer works as configured, the name of the print server appears as
a connected user.

O If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see Printer Reference.

O If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

O For details about the login user name and password, see Security Reference.
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Using Pure IP in the NetWare 5/5.1 or 6 / 6.5 Environment

Follow the procedure below to connect the machine as a print server in a pure IP
environment of NetWare 5 / 5.1 or NetWare 6 / 6.5.

iﬁklmportant

O When creating a queued print server in a pure IP environment of NetWare 5 /
5.1 or NetWare 6 / 6.5, create a print queue on the file server using NetWare
Administrator.

O This printer is not available as a remote printer for use in a pure IP environment.
O To use the printer in a pure IP environment, set it to IPv4.

Setting up using NWadmin

ﬂ From Windows, start NWadmin.
For details about NWadmin, see the NetWare manuals.

g Select the object in which the print queue is located in the directory tree,
and then click [Create] on the [Object] menu.

B In the [Class of new object] box, click [Print Queue], and then click [OK].
ﬂ In the [Print Queue Name] box, enter the name of the print queue.
B In the [Print Queue Volume] box, click [Browse].

B In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

ﬂ Check the settings, and then click [Create].

8 Select the object in which the printer is located, and then click [Create] on
the [Object] menu.

g In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare
5, click [Printer (Non NDPS)].

[[D In the [Printer name] box, enter the printer name.

[I] Select the [Define additional properties] check box, and then click [Create].

(B Click [Assignments], and then click [Add] in the [Assignments] area.

[B In the [Available objects] box, click the queue you created, and then click [OK].

[I] Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

iE Click [Manual load] in the [Communication type] area, and then click [OK].
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[E Check the settings, and then click [OK].

[ﬂ Select a context specified using NIB Setup Tool, and then click [Create] on
the [Object] menu.

[B In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

[ﬂ In the [Print Server Name] box, enter the print server name.
Use the same print server name specified using NIB Setup Tool.

EID Select the [Define additional properties] check box, and then click [Create].

H Click [Assignments], and then click [Add] in the [Assignments] area.

EB In the [Available objects] box, click the queue you created, and then click [OK].
EB Check the settings, and then click [OK].

Setting up using Web Image Monitor

ﬂ Open a Web browser, and then enter "http://(printer's address)/" in the address
bar. Top Page of Web Image Monitor appears.

B click [Login].
A dialog box for entering the [Login User Name] and [Login Password] appears.

B Enter the user login user name and password, and then click [Login].

For details about the login name and password, consult your network admin-
istrator.

ﬂ Click [Configuration] in the left area, and then click [NetWare].

B Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

(3 click [Logout].

& Note

O If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see Printer Reference.

O If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

O For details about the login user name and password, see Security Reference.
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Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the machine as a remote printer under Net-
Ware 3.x.

Setting up using PCONSOLE

ﬂ Enter “PCONSOLE” from the command prompt.
F:> PCONSOLE

ﬂ Create a print queue.
When using the existing print queue, go to the procedure for creating a printer.

B From the [Available Options] menu, select [Print Queue Information], and then
press the [ Enter] key.

ﬂ Press the [Insert] key, and then enter a print queue name.
B Press the [ Esc] key to return to the [Available Options] menu.
B Set up the network connection to a printer.

ﬂ On the [Available Options] menu, click [Print Server Information], and then press
the [ Enter] key.

8 To create a new print server, press the [Insert] key, and then enter a print
server name.

For a currently defined print server, select a print server in the [Print Server] list.
Use the same printer name specified using NIB Setup Tool.

g From the [Print Server Information] menu, select [Print Server Configuration].
[[D From the [Print Server Configuration] menu, select [Printer Configuration].

[ select the printer indicated as [Not Installed].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

[B To change the printer name, enter a new name.
£“_ 7

A name “printer x” is assigned to the printer. The “x” stands for the number
of the selected printer.

[ As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automatically
configured.

ﬂ] Press the [ Esc] key, and then click [Yes] on the confirmation message.
iE Press the [Esc] key to return to [Print Server Configuration Menu].
[E Assign print queues to the created printer.

[ﬂ From [Print Server Configuration Menu], select [Queues Serviced By Printer].
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[B Select the printer created.

[ﬂ Press the [Insert] key to select a queue serviced by the printer.
You can select several queues.

m Follow the instructions on the screen to make other necessary settings.
Following these steps, check that the queues are assigned.

mPress the [Esc] key until "Exit?" appears, and then select [Yes] to exit
PCONSOLE.

EB Start the print server by entering the following from the console of the Net-
Ware server.

If the print server is in operation, quit and restart it.
¢ To quit

CAREE: unload pserver
e To start

CAREE: load pserver print server name

& Note
O If the printer works as configured, the message "Waiting for job" appears.

Setting up using Web Image Monitor

ﬂ Open a Web browser, and then enter "http://(printer's address)/" in the address
bar. Top Page of Web Image Monitor appears.

B click [Login].
A dialog box for entering the [Login User Name] and [Login Password] appears.

8 Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

ﬂ Click [Configuration] in the left area, and then click [NetWare].

B Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

E Click [Logout].

& Note

O If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see Printer Reference.

O If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

O For details about the login user name and password, see Security Reference.
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Setting Up as a Remote Printer (NetWare 4.x,5/5.1, 6/ 6.5)

Follow the procedure below to use the printer as a remote printer under NetWare
4x,5/51and 6/ 6.5.

iﬁklmportant

O To use the printer as a remote printer under NetWare 4.x,5 / 5.1, 6 / 6.5, set it
to NDS mode.

O Do not use the printer as a remote printer when Pure IP is used.

Setting up using NWadmin

ﬂ From Windows, start NWadmin.
For details about NWadmin, see the NetWare manuals.

g Set up the network connection to a print queue. Select the object in which the print
queue is located in the directory tree, and then click [Create] on the [Object] menu.

8 In the [Class of new object] box, click [Print Queue], and then click [OK].
ﬂ In the [Print Queue Name] box, enter the name of the print queue.
B In the [Print Queue Volume] box, click [Browse].

B In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

ﬂ Check the settings, and then click [Create].

8 Set up the network connection to a printer. Select the object in which the
printer is located, and then click [Create] on the [Object] menu.

g In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare
5, click [Printer (Non NDPS)].

[m In the [Printer name] box, enter the printer name
[i] Select the [Define additional properties] check box, and then click [Create].

[B Assign print queues to the created printer. Click [Assignments], and then
click [Add] in the [Assignments] area.

[B In the [Available objects] box, click the queue you created, and then click [OK].

[I] Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

iE Click [Manual load] in the [Communication type] area, and then click [OK].
Check the settings, and then click [OK].

[ﬁ Set up the network connection to a print server. Select a context specified
using NIB Setup Tool, and then click [Create] on the [Object] menu.

[ﬂ In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

[E] In the [Print Server Name:] box, enter the print server name.
Use the same print server name specified using NIB Setup Tool.
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[E] Select the [Define additional properties] check box, and then click [Create].

EID Assign the printer to the created print server. Click [Assignments], and then
click [Add] in the [Assignments] area.

ﬂ] In the [Available objects] box, click the queue you created, and then click [OK].
@J In the [Printers] area, click the printer you assigned, and then click [Printer Number]

EB Enter the printer number, and then click [OK]. Check the settings, and then
click [OK].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

EZ] Start the print server by entering the following from the console of the Net-
Ware server.

If the print server is in operation, quit and restart it.

e To exit
CAREE: unload pserver

e To start
CAREE: load pserver print_server_ name

EB Enter the printer server name as the context name, and then press the [ Enter] key.

EE Select the printer name on the context menu, and then press the [ Enter] key.

Setting up using Web Image Monitor

ﬂ Open a Web browser, and then enter "http://(printer's address)/" in the address
bar. Top Page of Web Image Monitor appears.

9 Click [Login].
A dialog box for entering the [Login User Name] and [Login Password] appears.

B Enter the user login name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

ﬂ Click [Configuration] in the left area, and then click [NetWare].

B Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

(3 click [Logout].

& Note

O If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see Printer Reference.

O If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

O For details about the login user name and password, see Security Reference.



2. Monitoring and Configuring

the Printer

Using Web Image Monitor

Using Web Image Monitor, you can check the machine status and change settings.

< Available operations
The following operations can be remotely performed using Web Image Monitor
from a client computer.

K7
*o*

R
**

Displaying machine status or settings
Checking the print job status or history

Checking, modifying, printing, or deleting print jobs stored in the Document
Server

Interrupting currently printing jobs
Resetting the printer

Managing the Address Book

Making machine settings

Making network protocol settings

Making security settings

Downloading, deleting, or printing print jobs

Configuring the machine

To perform the operations from Web Image Monitor, TCP/IP is required. After
the machine is configured to use TCP/IP, operations from Web Image Monitor
become available.

Recommended Web browser

Windows:
Internet Explorer 5.5 SP2 or higher
Firefox 1.0 or higher

Mac OS:
Firefox 1.0 or higher
Safari 1.0, 1.2, 2.0(412.2) or higher

Web Image Monitor supports screen reader software. We recommend JAWS
7.0 or a later version.
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& Note
O Safari cannot be used on Mac OS X 10.4.1.

O Display and operation problems can occur if you do not enable JavaScript and
cookies, or if you are using a non-recommended Web Browser.

O If you are using a proxy server, change the Web browser settings. Contact
your administrator for information about the settings.

O Machine information is not automatically updated. To perform an update,
click [Refresh] in the display area.

O We recommend using Web Image Monitor in the same network.
O You cannot access to the machine from outside the firewall.

O When using the machine under DHCP, the IP address may be automatically
changed by the DHCP server settings. Enable DDNS setting on the machine,
and then connect using the machine's host name. Alternatively, set a static IP
address to the DHCP server.

O If the HTTP port is disabled, connection to the machine using the machine's
URL cannot be established. SSL setting must be enabled on this machine. For
details, consult your network administrator.

O When using the SSL encryption protocol, enter “https://(printer's ad-
dress)/”. Internet Explorer must be installed on your computer. Use the most
recent available version. We recommend Internet Explorer 6.0 or later.

O When you are using Firefox, fonts and colors may be different, or tables may
be out of shape.

O When using a host name under Windows Server 2003 with IPv6 protocol, per-
form host name resolution using an external DNS server. The host file cannot
be used.

O To use JAWS 7.0 under Web Image Monitor, you must be running Windows
OS and Microsoft Internet Explorer 5.5 SP2, or a later version.
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Displaying Top Page

This section explains the Top Page and how to display Web Image Monitor.
ﬂ Start your Web browser.

ﬂ Enter “http://(machine's address)/” in the address bar of a Web browser.
Top Page of Web Image Monitor appears.

If the machine's host name has been registered on the DNS or WINS server,
you can enter it.

When setting SSL, a protocol for encrypted communication, under environment
which server authentication is issued , enter "https:/ /(machine's address)/".

Every Web Image Monitor page is divided into the following areas:

. Menu area

If you select menu, it's content will be
shown on the work area, or the sub area.

. Tab area
Details about each menu appears.

. Header area

The dialog box for switching to the
user mode and administrator mode
appears, and each mode's menu will
be displayed.

The link to help and dialog box for
keyword search appears.

& Note

ATW102S

4. Help

Use Help to view or download Help
file contents.

. Display area

Displays the contents of the item select-
ed in the menu area.

Machine information in the display
area is not automatically updated.
Click [Refresh] at the upper right in the
display area to update the machine in-
formation. Click the Web browser's
[Refresh] button to refresh the entire
browser screen.

O When using a host name under Windows Server 2003 with IPv6 protocol,
perform host name resolution using an external DNS server. The host file

cannot be used.
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When user authentication is set

Login (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.
0 click [Login].

ﬂ Enter a login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

& Note

3 For user code authentication, enter a user code in [User Name], and then click
[OK].

O The procedure may differ depending on the Web browser used.

Log Off (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.
Click [Logout] to log off.

& Note
O After you log on and change configurations, make sure to always [Logout].
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About Menu and Mode

There are two modes available with Web Image Monitor: user mode and admin-

istrator mode.

Displayed Items may differ depending on the machine type.

< About Guest Mode

In the guest mode, machine status, settings, and print job status can be
viewed, but the machine settings cannot be changed.
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1. Home

The [Status], [Configuration], [Counter],
and [Inquiry] tab are displayed. Details
of the tab menu are displayed on the
work area.

2. Document Server

Display files stored in the Document
Server.

ATW103S

3. Printer: Print Jobs

Allows you to display list of Sample
Print, Locked Print, Hold Print, and
Stored Print jobs.

4. Job
Display all print files.

5. Configuration

Display current machine and network
settings.
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« Administrator Mode

In the administrator mode, you can configure various machine settings.
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1. Home

The [Status], [Configuration], [Counter],
and [Inquiry] tab are displayed. Details
of the tab menu are displayed on the
work area.

2. Document Server
Display files stored in the Document
Server.

3. Printer: Print Jobs
Allows you to display list of Locked
Print, Sample Print, Hold Print, and
Stored Print jobs.

4. Job
Display all print files.

ATW104S

. Address Book

User information can be registered,

displayed, changed, and deleted.

. Configuration

Make system settings for the machine,
interface settings, and security.

. Reset Device

Click to reset the printer. If a print job
is being processed, the printer will be
reset after the print job is completed.
This button is located on Top Page.

. Reset Printer Job

Click to reset current print jobs and
print jobs in queue. This button is lo-
cated on Top Page.

Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator mode.

ﬂ On Top Page, click [Login].

The dialog box for entering the user name and password appears.

g Enter your login user name and password, and then click [Login].

For details about the login user name and password, consult your network

administrator.

& Note

O For details about the login user name and password, see Security Reference.
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List of the Setting ltems

The following tables show Web Image Monitor items that can be viewed or mod-
ified depending on the selected mode on the Web browser. Select one of the fol-
lowing modes to log on Web Image Monitor:

¢ User mode: logged on as a user

¢ Administrator mode: logged on as an administrator

% Home
Status
Menu User mode Administrator mode
Status Read Read /Modify
Toner Read Read
Input Tray Read Read
Output Tray Read Read
Device Info
Menu User mode Administrator mode
Functions Read Read
System Read Read
Version Read Read
Printer Language Read Read
Counter
Menu User mode Administrator mode
Copier Read Read
Printer Read Read
Send/TX Total Read Read
Scanner Send Read Read
Inquiry
Menu User mode Administrator mode
Machine Maintenance/Repair Read Read
Sales Representative Read Read
 Address Book
Menu User mode Administrator mode
Address Book None Read/Modify

< Document Server
Document Server

User mode Administrator mode

Read /Modify Read /Modify 33
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« Printer: Print Jobs

Print Job List
User mode Administrator mode
Read /Modify Read /Modify
% Job
Job List
Menu User mode Administrator mode
Current/Waiting Jobs Read Read /Modify
Job History Read Read
Printer
Menu User mode Administrator mode
Spool Printing Read Read /Modify
Job History Read Read /Modify
Error Log Read Read
Document Server
Menu User mode Administrator mode
Print Job History Read Read
Scanner Remote Send History Read Read
« Configuration
Device Settings
Menu User mode Administrator mode
System Read Read /Modify
Paper Read Read /Modify
Date/Time Read Read /Modify
Timer Read Read /Modify
Logs None Read /Modify
E-mail Read Read /Modify
Auto E-mail Notification None Read /Modify
On-demand E-mail Notification None Read /Modify
File Transfer None Read/Modify
User Authentication Management | None Read/Modify
Administrator Authentication None Read /Modify
Management
Program/Change Administrator | None Read /Modify
LDAP Server None Read /Modify
Firmware Update None Read /Modify
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Printer
Menu User mode Administrator mode
Basic Settings Read Read /Modify
Tray Parameters (PS) None Read /Modify
PDF Temporary Password Modify None
PDF Group Password None Modify
PDF Fixed Password None Modify
Interface
Menu User mode Administrator mode
Interface Settings Read Read /Modify
Wireless LAN Settings Read Read/Modify
Network
Menu User mode Administrator mode
IPv4 Read Read /Modify
IPv6 Read Read /Modify
NetWare Read Read/Modify
AppleTalk Read Read /Modify
SMB Read Read /Modify
SNMP None Read /Modify
SNMPv3 None Read /Modify
SSDP None Read /Modify
Bonjour Read Read /Modify
System Log Read Read
Security
Menu User mode Administrator mode
Network Security None Read /Modify
Access Control None Read /Modify
IPP Authentication None Read/Modify
SSL/TLS None Read /Modify
ssh None Read /Modify
Site Certificate None Read /Modify
Device Certificate None Read /Modify
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RC Gate
Menu User mode Administrator mode
Setup RC Gate None Read /Modify
Update RC Gate Firmware None Read /Modify
RC Gate Proxy Server None Read /Modify
Webpage
Menu User mode Administrator mode
Webpage Read /Modify Read /Modify

Extended Feature Settings

Menu User mode Administrator mode

Startup Setting None Read /Modify
Extended Feature Info Read Read

Install None Read /Modify
Uninstall None Read/Modify
Change Allocation None Read /Modify
Administrator Tools None Read/Modify
Copy Extended Features None Read /Modify
Copy Card Save Data None Read /Modify

& Note
O Some items are not displayed depending on the security settings.
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Displaying Web Image Monitor Help

When using Help for the first time, clicking either [Help] in the header area or the
icon marked "?" in the display area makes the following screen appear, in which
you can view Help in two different ways, as shown below:

% Viewing Help on our Web site
Downloading Help to your computer

< Downloading and Checking Help
You can download Help to your computer. To view Help without connecting
to the Internet, enter the path to your local Help files in your browser's URL bar.

& Note
O By clicking [Help] in the header area, the contents of Help appear.

O You can view Help for a setting by clicking "?", the Help icon, in the display area.

Downloading Help

ﬂ In the [0S] list, select the operating system.

ﬂ In the [Language] list, select the language.

B click [pownload.

ﬂ Download Help by following the instructions on the screen.

B Store the downloaded compressed file in a location, and then decompress
the file.

To view the downloaded Web Image Monitor Help, set the path to the location
of the decompressed file.

Linking the URL of the Help File to the [Help] Button.

You can link the URL of the help file on a computer or Web server to the [Help]
button.

ﬂ Log on to Web Image Monitor in the administrator mode.
B 1n the menu area, click [Configuration].
B Click [Webpage].

ﬂ In the [URL] box, enter the URL of the help file.

For example, if you saved the file to a Web server, and the URL of the index file
is "http:// a.b.c.d/HELP/EN/index.html", enter "http:/ /a.b.c.d/HELP/".

B ciick [ok).
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Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you can monitor the network printers. Al-
so, you can change the configuration of the network interface board using TCP /1P
or IPX/SPX.

ﬂlmportant
O IPv6 cannot be used on this function.

% Protocol stack provided with Operating System

e Windows 95/98/Me
TCP/IP
IPX/SPX
NetWare
NetWare Client32 for Windows 95
IntraNetWare Client for Windows 95
Novell Client for Windows 95/98 /Me

e Windows 2000
TCP/IP
IPX/SPX
NetWare
Novell Client for Windows NT /2000/XP

e Windows Server 2003
TCP/IP
IPX/SPX

e Windows XP
TCP/IP
IPX/SPX
Novell Client for Windows NT /2000/XP

e Windows NT 4.0
TCP/IP
IPX/SPX
Client Service for NetWare
NetWare Client32 for Windows NT
IntraNetWare Client for Windows NT
Novell Client for Windows NT /2000/XP
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« Available operations
The following functions are available:

Limits settings done from the control panel, and disables changes made to
certain items.

Enables selection of paper type loaded in the machine.
Switches to, and comes out of Energy Save Mode.
Checks information about printing, paper quantity, etc.

Simultaneously monitors multiple printers. When there are many printers,
you can create groups and classify printers to facilitate management.

Checks the machine's network settings and detailed device information.
Enables you to change the machine's network settings.
You can check details of print jobs sent from a computer.

Allows you to check job histories of printed, scanned, and photocopied
documents identified by user codes.

Allows selection of functions such as printing and scanning for each user code.
You can make settings for and display the status changes of group devices.

Using Address Management Tool, you can manage user names for Scan to
Folder.

The e-mail sender’s name and folder can be protected.
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Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin
ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].

The following languages are available: Czech, Danish, German, English,
Spanish, French, Italian, Hungarian, Dutch, Norwegian, Polish, Portuguese ,
Finnish, Swedish, Chinese Simple and Chinese Traditional.

E] Click [SmartDeviceMonitor for Admin].

B Click [Next>].
The software license agreement appears in the [License Agreement] dialog box.

E After reading through its contents, click [Next >].

ﬂ Follow the instructions on the screen.
A message appears when the installation is completed.

B crick [ok).

A message about restarting the computer may appear. Restart the computer
to complete installation.

&P Note

O Auto Run may not work under certain operating system settings. In this
case, launch “Setup.exe” located on the CD-ROM root directory.

O If you are required to restart the computer after installing SmartDevice-
Monitor for Admin, restart the computer and continue the configuration.
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Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configuration
using SmartDeviceMonitor for Admin.

ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group:] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.
Select the protocol of the machine whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

B In the list, select a machine whose configuration you want to change.

O 0n the [Tools] menu, click [NIB Setup Tool].

NIB Setup Tool starts when the network interface board is default. Click [Web
browser], and then click [OK].

B A Web browser opens and enter the login user name and password, and then
click [Login].

For details about the login user name and password, consult your network
administrator.

E Configure settings using Web Image Monitor.
ﬂ Quit Web Image Monitor.
B Quit SmartDeviceMonitor for Admin.

& Note
O For details about the login user name and password, see Security Reference.

A Reference
For details about Web Image Monitor, see p.27 “Using Web Image Monitor”
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Locking the Menus on the Machine's Control Panel

Follow the procedure below to lock the menus on the machine's control panel.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group:] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.
Select the protocol of the machine whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

B Select a machine.

ﬂ On the [Tools] menu, point to [Device Settings], and then click [System].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

B Enter the login user name and password, and then click [Login].

For details about the user name and password, consult your network admin-
istrator.

The [System] page of Web Image Monitor appears. Enter required setting
items.

B Quit Web Image Monitor.
ﬂ Quit SmartDeviceMonitor for Admin.

& Note
O For details about setting items, see Help in the [General Settings] on [Config-
uration] page.

O For details about the login user name and password, see Security Reference.



Using SmartDeviceMonitor for Admin

Changing the Paper Type

Follow the procedure below to change the paper type.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group:] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.
Select the protocol of the machine whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

B In the list, select a machine whose configuration you want to change.

ﬂ On the [Tools] menu, point to [Device Settings], and then click [System].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

B Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

The [Paper] page appears.

Select a paper type in the [Paper Type] list for each tray. Enter required setting
items.

B Quit Web Image Monitor.
ﬂ Quit SmartDeviceMonitor for Admin.

& Note
O For details about setting items, see Help in the [General Settings] on [Config-
uration] page.

O For details about the login user name and password, see Security Reference.
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Managing User Information

Follow the procedure below to manage the user's information using SmartDevice-
Monitor for Admin.

Prints jobs can be managed and functions restricted by user codes.

Starting Address Management Tool

Follow the procedure below to start User Management Tool.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group:] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.
Select the protocol of the machine whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

B In the list, select a machine you want to manage.

ﬂ On the [Tools] menu, click [User Management Tool].
The dialog box for entering the login user name and password appears.

B Enter the user name and password, and then click [OK].

For details about the user name and password, consult your network admin-
istrator.

User Management Tool starts.
& Note

O For details about User Management Tool, see SmartDeviceMonitor for Admin
Help.

O For details about the login user name and password, see Security Reference.

Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each
user code.

ﬂ Start SmartDeviceMonitor for Admin User Management Tool.

ﬂ Click the [User Counter Information] tab of User Management Tool.
The number of pages printed under each user code appears.

B Click [Exit] on the [File] menu to quit User Management Tool.
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Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages
printed under each user code as a .csv file.

ﬂ Start SmartDeviceMonitor for Admin User Management Tool.

ﬂ Click the [User Counter Information] tab of User Management Tool.

8 On the [File] menu, click [Export User Statistics List].
ﬂ Specify the save location and file name, and then click [Save].

B Click [Exit] on the [File] menu to quit User Management Tool.

Resetting the number of pages printed to 0.

Follow the procedure below to reset the number of pages printed under each
user code to 0.

ﬂ Start SmartDeviceMonitor for Admin User Management Tool.
ﬂ Click the [User Counter Information] tab of User Management Tool.
8 Click the user whose information you want to reset.

ﬂ On the [Edit] menu, click [Reset User Counters].

B Select the check box of the items you want to reset, and then click [OK].
A confirmation message appears.

(3 ciick [ok).
The number of pages printed is reset to 0.

d On the [Edit] menu, click [Apply Settings].
Changes are applied to information on the [User Counter Information] tab.

8 Click [Exit] on the [File] menu to quit User Management Tool.
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Restricting Functions

Follow the procedure below to restrict use of individual functions.

ﬂ Start SmartDeviceMonitor for Admin User Management Tool.

ﬂ Click the [User Counter Information] tab of User Management Tool.

B Click the user whose functions you want to restrict.

ﬂ On the [Edit] menu of User Management Tool, click [Restrict Access To Device].
B Select the check box of the functions you want to restrict.

(3 ciicx fox.
A confirmation message appears.

U click [ves.
The settings are applied.

Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to them.
ﬂ Start SmartDeviceMonitor for Admin User Management Tool.

ﬂ Click the [Access Control List] tab of User Management Tool.

E] On the [Edit] menu, click [Add New User].

ﬂ Enter the user code and user name.

B Select the check box of the functions applicable to the new user.
If the check boxes are unavailable, there is no restriction to use that function.

(3 ciick [ok).
The new user is added.

d On the [Edit] menu, click [Apply Settings].
The settings are applied.

B Click [Exit] on the [File] menu to quit User Management Tool.

& Note

O For details about setting restrictions, see SmartDeviceMonitor for Admin
Help.
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Configuring the Energy Save Mode

Follow the procedure below to configure Energy Save Mode.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group:] menu, point to [Yes], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of machines using the selected protocol appears.
Select the protocol of the machine whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

B Select the machine whose settings you want to make.
To make settings for all machines in the selected group, select no machine.

ﬂ On the [Group:] menu, point to [Energy Save Mode], point to [Set Individually] to
make the settings for only the selected machine or point to [Set By Group] to
make the settings for all machines in the selected group, and then click [On]
or [Off].

B Quit SmartDeviceMonitor for Admin.

& Note
O For details about the setting for Energy Save mode, see SmartDeviceMonitor
for Admin Help.
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Setting a Password

Follow the procedure below to set a password.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group:] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.
Select the protocol of the machine whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

B In the list, select a machine whose configuration you want to change.

O 0n the [Tools] menu, click [NIB Setup Tool].

NIB Setup Tool starts when the network interface board is default. Click [Web
browser], and then click [OK].

B A Web browser opens and enter the login user name and password, and then
click [Login].

For details about the user name and password, consult your network admin-
istrator.

ﬂ Click [Configuration].

ﬂ Click [Program/Change Administrator] on the [Device Settings] area, and then
change the settings.

B Quit Web Image Monitor.
g Quit SmartDeviceMonitor for Admin.

& Note
O For details about the login user name and password, see Security Reference.
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Checking the Machine Status

Follow the procedure below to check machine status.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group:] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.
Select the protocol of the machine whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

B To obtain status details, select the machine in the list, and then click [Open]
on the [Device] menu.

The machine status appears in the dialog box.

O click [System] or [Printer].
The machine status appears in the dialog box.

B Quit SmartDeviceMonitor for Admin.

¢ Note
O For details about items in the dialog box, see SmartDeviceMonitor for Admin
Help.
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Changing Names and Comments

Follow the procedure below to change the names and comments of the machine.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group:] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.
Select the protocol of the machine whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

B Select a machine in the list, and then click [NIB Setup Tool] on the [Tools] menu.
NIB Setup Tool starts when the network interface board is default. Click [Web
browser], and then click [OK].

ﬂ A Web browser opens and enter the login user name and password, and
then click [Login].

For details about the login user name and password, consult your network
administrator.

B ciick [Configuration].

E Click [System] on the [Device Settings] area, and then change the settings.
ﬂ Quit Web Image Monitor.

8 Quit SmartDeviceMonitor for Admin.

& Note

O In the [Device Name] box, enter a device name on the machine using up to 31
characters.

O In the [Comment] box, enter a comment on the machine using up to 31 char-
acters.

O For details about the login user name and password, see Security Reference.
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Viewing and Deleting Spool Print Jobs

ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group:] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.
Select the protocol of the machine whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

B Select a machine in the list, and then click [Spool Printing Job List(Printer)] on
the [Tools] menu.

A Web browser opens and the dialog box for entering the login user name
and password for the Web Image Monitor administrator appears.

ﬂ Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

Spool Printing Job List appears in the Web Image Monitor.
To delete the Spool Printing Job, select the document you want to delete and
then click [Delete].

&P Note

O To display Spool Printing Job List, spool must be set to [Enable] on Web Image
Monitor in advance.

O For details, see Help in the Spool Printing Job List area.
O For details about the login user name and password, see Security Reference.
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Managing Address Information

ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group:] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.
Select the protocol of the machine whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

B Select a machine in the list, and then click [Address Management Tool] on the
[Tools] menu.

The dialog box for entering the login user name and password appears.

ﬂ Enter the login user name and password, and then click [OK].
Address Management Tool starts.

For details about the login user name and password, consult your network
administrator.

& Note
O For details, see Address Management Tool Help.

O For details about the login user name and password, see Security Reference.



Using SmartDeviceMonitor for Client

Using SmartDeviceMonitor for Client

To view the status of machines using SmartDeviceMonitor for Client, configure
SmartDeviceMonitor for Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the machine using SmartDeviceMonitor
for Client.

ﬂ Right-click the SmartDeviceMonitor for Client icon on the task tray, point
to [Properties], and then click [Options...].

The [SmartDeviceMonitor for Client - Options] dialog box appears.

ﬂ Select the machine you want to monitor, and then select the [To be Monitored]
check box in the Monitoring Information Settings area.

To display the machine status in the task tray using the SmartDeviceMonitor
for Client icon, select the [Displayed on Task Bar] check box.

B click [ok).

The dialog box closes and the configured machine is monitored.

& Note
O For details about status icons, see SmartDeviceMonitor for Client Help.

Checking the Machine Status

Follow the procedure below to check machine status using SmartDeviceMonitor
for Client.

ﬂ For status details, right-click the SmartDeviceMonitor for Client icon on
the task tray, and then click the machine.
The machine status appears in the dialog box.
& Note

O For details about items in the dialog box, see SmartDeviceMonitor for Client
Help.
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When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:

The network printer can only receive one print job from SmartDeviceMonitor
for Client at a time. While the network printer is printing, another user cannot
access it until the job is finished. In this case, SmartDeviceMonitor for Client
tries to access the network printer until the retry interval expires.

If SmartDeviceMonitor for Client cannot access the network printer and times
out, it will stop sending the print job. In this case, you should cancel the paused
status from the print queue window. SmartDeviceMonitor for Client will
resume access to the network printer. You can delete the printjob from the print
queue window, but canceling a print job printed by the network printer might
cause the next job sent from another user to be incorrectly printed.

If a print job sent from SmartDeviceMonitor for Client is interrupted and the
network printer cancels the job because something went wrong, send the
print job again.

Print jobs sent from another computer do not appear in the print queue win-
dow, regardless of protocol.

If various users send print jobs using SmartDeviceMonitor for Client to net-
work printers, the printing order might not be the same as that in which the
jobs were sent.

An IP address cannot be used for the IPP port name because the IP address is
used for the SmartDeviceMonitor for Client port name.

When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentication is issued, enter "https://(machine's ad-
dress)/". Internet Explorer must be installed on your computer. Use the highest
version. Internet Explorer 6.0 or higher is recommended.

If the [Security Alert] dialog box appears when accessing the machine using IPP
to create or configure an IPP port, or when printing, install the certificate. To
select the certificate store location when using Certificate Import Wizard,
click [Place all certificates in the following store], and then click [Local Computer]
under [Trusted Root Certification Authorities].

& Note
O For details about SSL settings, consult your network administrator.



Printer Status Notification by E-Mail

Printer Status Notification by E-Mail

Whenever a paper tray becomes empty or paper is jammed, an e-mail alert is is-
sued to the registered addresses to notify the printer status.

For this notification, you can make the e-mail notification settings.
Notification timing and e-mail content can be set.

You can be notified of the following events:

¢ Service call.

* Toner cartridge is empty.

¢ Toner cartridge is nearly empty.

e Waste toner bottle (waste toner ink tank) is full.

* Waste toner bottle (waste toner ink tank) is nearly full.
¢ Punch dust is full

¢ Paper has jammed.

* Open door is detected.

* The paper tray is empty.

* The paper tray is nearly empty.

* A paper tray error occurred.

¢ Output paper tray is full.

¢ Unit connection error.

¢ Duplex unit error.

¢ Hard disk drive is full.

& Note
O When the service call is set, following call results can be sent.

e Failure automatic call success
e Failure automatic call out of time
e Failure automatic call failure
e Consumable automatic call success
e Consumable automatic call success
¢ Remote machine check failure
* Firmware update confirmed
O Other call results can be displayed, depending on the machine type.
O For details about the service call, contact your service or sales representative.
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ﬂ Open a Web browser, and then enter “http://(machine's address)/” in the
address bar.

Top Page of Web Image Monitor appears.

When setting SSL, a protocol for encrypted communication, under environment
which server authentication is issued , enter “https://(machine's address)/”.

ﬂ Click [Login] on Top Page of Web Image Monitor.
The window for entering the login user name and password appears.

B Enter the login user name and password, and then click Login.

For details about the login user name and password, consult your network
administrator.

ﬂ In the menu area, click [Configuration].
B Click [E-mail] on the [Device Settings] area.

E Make the following settings:

¢ Administrator E-mail Address: Make the address settings for receiving e-
mail notification when there is a problem with the machine or consumables
need replacing.

¢ Items in the Reception column: Make the necessary settings for sending
and receiving e-mail.

¢ [Items in the SMTP column: Configure the SMTP server. Check your mailing
environment, and then specify the necessary items. You can also perform
mail authentication for the SMTP server.

¢ [Items in the POP before SMTP column: Configure the POP server. Check
your mailing environment, and then specify the necessary items. You can
also perform mail authentication for the POP server.

¢ Items in the POP3/IMAP4 column: Configure the POP3 or IMAP4 server.
Check your mailing environment, and then specify the necessary items.

¢ [Items in the E-mail Communication Port column: Configure the port to be
used for access to the mail server.

¢ Jtems in the E-mail Notification Account column: Items in the E-Mail Noti-
fication Account column: Specify these items if you want to use on-demand
e-mail notification.

U crick [ok).
B Click [Logout].
g Quit Web Image Monitor.

& Note
O For details about the login user name and password, see Security Reference.
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Auto E-mail Notification

ﬂ Click [Configuration] in the menu area, and then click [Auto E-mail Notification]
on the [Device Settings] area.

The dialog box for making notification settings appears.

ﬂ Make the following settings:

¢ Jtems in Notification Message column: You can set this according to your
needs, for example, the machine's location, service representative contact
information.

¢ [Items in the Groups to Notify column: E-mail notification addresses can be
grouped as required.

¢ [Items in the Select Groups/Items to Notify column: Select groups for each
notification type, such as machine status and error.
To make detailed settings for these items, click [Edit] next to [Detailed Settings
of Each ltem].

B ciick [ok).
ﬂ Click [Logout].
B Quit Web Image Monitor.

On-demand E-mail Notification

ﬂ Click [Configuration] in the menu area, and then click [On-demand E-mail Notifi-
cation] on the [Device Settings] area.

The dialog box for making notification settings appears.

ﬂ Make the following settings:

* Notification Subject: Enter a text string to be added to the subject line of return
e-mails.

* Notification Message: You can set this according to your needs, for example,
the machine's location, service representative contact information.

e Jtems in the Access Restriction to Information column: Select whether to
restrict accesses based on a specific category of information.

¢ Jtems in the Receivable E-mail Address/Domain Name Settings column:
Enter an e-mail address or domain name to use for requesting information
by e-mail and to receive its return e-mail.

B click [ok).
O click [Logout].
B Quit Web Image Monitor.
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Mail authentication

You can configure mail authentication to prevent illegal use of the mail server.

< SMTP Authentication
Specify SMTP authentication.
When mail is sent to the SMTP server, authentication is performed using the
SMTP AUTH protocol by prompting the mail originator to enter the user
name and password. This prevents illegal use of the SMTP server.

@ Click [Configuration] In the menu area, and then click [On-demand E-mail Notifi-
cation] on the [Device Settings] area.

® Make the following settings:
e SMTP Authentication: Enable or disable SMTP authentication.
e SMTP Auth. E-mail Address: Enter the e-mail address.
e SMTP Auth. User Name: Enter the SMTP account name.
¢ SMTP Auth. Password: To set or change the password for SMTP AUTH.

¢ SMTP Auth. Encryption: Select whether to encrypt the password or not.
[Encryption]-[Auto Select]: If the authentication method is PLAIN, LOGIN,
CRAM-MD?5, or DIGEST-MD5.
[Encryption]-[Active]: If the authentication method is CRAM-MDS5 or DI-
GEST-MD5.
[Encryption]-[Inactive]: If the authentication method is PLAIN or LOGIN.

® Click [OK]
@ Click [Logout].
® Quit Web Image Monitor.

< POP before SMTP Authentication
Select whether to log on to the POP3 server before sending e-mail.

@ Click [Configuration] In the menu area, and then click [On-demand E-mail Notifi-
cation] on the [Device Settings] area.

® Make the following settings:
e POP before SMTP: Enable or disable POP before SMTP.
¢ POP E-mail Address: Enter the e-mail address.
e POP User Name: Enter the POP account name.
* POP Password: To set or change the POP password.

* Timeout setting after POP Auth.: Enter the time available before connecting
to the SMTP server after logging on to the POP server.

® Click [OK].
@ Click [Logout].
® Quit Web Image Monitor.
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Using On-demand E-mail Notification

To use on-demand e-mail notification, perform the following configuration
tasks in Web Image Monitor.

@ Click [Configuration] In the menu area, and then click [On-demand E-mail Notifi-
cation] on the [Device Settings] area.

® Make the following settings:

¢ E-mail Notification E-mail Address: Enter the address using alphanumeric
characters.

¢ Receive E-mail Notification: Specify whether to use on-demand e-mail no-
tification.

¢ E-mail Notification User Name: Enter the administrator's user name as the
mail originator name.

¢ E-mail Notification Password: Enter the password of the mail notification
user.

® Click [OK].
@ Click [Logout].
® Quit Web Image Monitor.

« Format of on-demand e-mail messages
To use mail notification, you need to send an on-demand e-mail message to
this machine.
Using your mail software, enter the following:

Item Description
Subject (Referred to as Subject) Enter a request regarding the device. For details, see
the table below.
From (Referred to as From) Specify a valid mail address. The device information
will be sent to the address specified here.

& Note
O A mail message must be within 1 MB in size.

O E-mail may be incomplete if sent immediately after power on.

% Subiject field

Format: devicestatus?parameter-name=parameter|&=parameter][&=parameter]...

& Note
O The Subject field is case-insensitive.

O Parameter names can be written in any order.
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« Subject field coding examples

Coding example

Action

devicestatus?request=sysconfig&
format=text&lang=en

The device's system configuration information will be
sent in an English text format.

devicestatus?request=sysconfig

The device's system configuration information will be
sent in a preset format and language.

< Parameters

Parameter Meaning Default
request Information to be obtained | Mandatory
format Mail format Mail will be sent in the format preset
for each mail address.
lang Language for mail body Mail will be sent in the language
preset for each mail address.

% Parameters specifying the information to be obtained

Information to be obtained Parameter
System configuration information sysconfig
Network configuration information netconfig
Printer configuration information prtconfig
Supplies information supply
Device status information status
« Parameters specifying the mail format
Mail format Parameter
Text text
HTML html
XML xml
& Note

O HTML and XML can be selected for subject field, but output is text only.

% Parameters that specify the language for mail bodies

Language

Parameter

Japanese

English

en




Remote Maintenance by telnet

Remote Maintenance by telnet

ﬂklmportant
O Remote Maintenance should be password-protected so that access is allowed
to administrators only.

O The password is the same as the one of Web Image Monitor administrator.
When the password is changed using "mshell", other passwords change also.

O Some command cannot be set depending on the model type.

Using telnet

Follow the procedure below to use telnet.

iﬁklmportant

O Only one user at a time can log on to perform remote maintenance.

ﬂ Use the IP address or the host name of the machine to start telnet.
% telnet IP_address

ﬂ Enter your user name and password.

For details about the user name and password, consult your network admin-
istrator.

For user authentication, enter a login user name and password.
For user code authentication, enter a user code in User Name.

B Enter a command.

ﬂ Quit telnet.
msh> logout

The configuration message about saving the changes appears.

B Enter "yes" to save the changes, and then press the [ Enter] key.

If you do not want to save the changes, enter "'no", and then press the [ Enter]
key. To make further changes, enter "return" at the command line, and then
press the [Enter] key.

4 Note

O If the message "Can not write NVRAM information" appears, the changes
are not saved. Repeat the procedure above.

O When the changes are saved, the network interface board is reset automat-
ically with that changes.

O When the network interface board resets, the print job in print process will
be printed. However, print jobs in queue will be canceled.
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access

Use the “access” command to view and configure access control. You can also
specify two or more access ranges.

% View settings
msh> access

% IPv4 Configuration
msh> access % range “start-address end-address”
* The star mark represents a target number between 1 and 5. (Up to five access
ranges can be registered and selected.)
Example: to specify accessible IPv4 addresses between 192.168.0.10 and 192.
168.0.20:

msh> access 1 range 192.168.0.10 192.168.0.20

R
**

IPv6 Configuration
msh> access % range6 “start-address end-address”

* The star mark represents a target number between 1 and 5. (Up to five access
ranges can be registered and selected.)

Example: to specify accessible IPv6 addresses between 2001:DB8::100 and

2001:DB8::200.

msh> access 1 range6 2001:DB8::100 2001:DB8::200

R
**

IPv6 access mask Configuration
msh> access % mask6 “base-address prefixlen”

* The star mark represents a target number between 1 and 5. (Up to five access
ranges can be registered and selected.)
Example: to specify accessible IPv6 addresses to 2001:DB8:: /32

msh> access 1 mask6 2001:DB8:: 32

< Access control initialization
msh> access flush

¢ Use the "flush" command to restore the default settings so that all access
ranges become "0.0.0.0" for IPv4, and "::" for IPv6.

& Note

O The access range restricts computers from use of the machine by IP address. If you
do not need to restrict printing, make the setting "0.0.0.0" for IPv4, and "::" for IPv®6.

O Valid ranges must be from lower (start address) to higher (end address).

O If you are running IPv4 or IPv6, up to five access ranges can be registered and selected.

O IPv6 can register and select the range and the mask for each access ranges.

O IPv6 mask ranges between 1 - 128 can be selected.

O Up to five access ranges can be specified. The entry is invalid if the target number
is omitted.

O You cannot send print jobs, or access Web Image Monitor and diprint from a
restricted IP address.
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authfree

Use the “authfree” command to display and configure authentication exclusion
control settings.

% View Settings

msh> authfree
If print job authentication exclusion is not set, authentication exclusion control
cannot be displayed.

% IPv4 address settings

msh> authfree "ID" range addrl range_addr2

R
**

IPv6 address settings

msh> authfree "ID" range6_addrl range6_addr2

R
**

IPv6 address mask settings

msh> authfree "ID" mask6_addrl masklen

« Parallel/USB settings

msh> authfree [parallel|usb] [on]|off]
To enable authfree, set to "on". To disable authfree, set to "off".
Always specify the interface.

< Authentication exclusion control initialization

msh> authfree flush

& Note
O For IPv4 and IPv6, up to five access ranges can be registered and selected.
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autonet

Use the “autonet” command to configure AutoNet parameters.
% View settings
The following command displays the current AutoNet settings:
msh> autonet
% Configuration
You can configure AutoNet settings.
msh> autonet {on|off}

e {on} means "active" and {off} means "inactive".

« Current interface priority configuration display

msh> autonet priority

« Interface priority configuration
msh> autonet priority “interface_ name”

* You can give interface's AutoNet parameter priority.

* Priority settings are available when multiple interfaces are installed.
* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet interface
wlan IEEE 802.11b interface
& Note

O If an interface is not selected, the current interface connection settings remain

in effect.

O For details about AutoNet, refer to autonet parameters.
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bonjour (rendezvous)

Use the “bonjour (rendezvous)” command to display bonjour (rendezvous) - related
settings.

% View settings

Bonjour settings are displayed.

msh> bonjour

++ Bonjour service name setting
You can specify the bonjour service name.
msh> bonjour cname “computer name”

* The computer name can be entered using up to 63 alphanumeric characters.

+ Bonjour Installation location information setting
You can enter information about the location where the printer is installed.
msh> bonjour location “location”

* Information about location can be entered using up to 32 alphanumeric characters.

% Setting order of priority for each protocol

diprint:

msh> bonjour diprint [0-99]
lpr:

msh> bonjour lpr [0-99]
ipp:

msh> bonjour ipp [0-99]

You can specify the order of priority for “diprint”, “lpr”, and “ipp”. Smaller
numbers indicate higher priority.

% IP TTL setting
msh> bonjour ip ttl {1-255}
You can specify the IP TTL (the number of routers a packet can pass through).

& Note
O The default is 255.
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+ Resetting the computer name and location information
You can reset the computer name and location information.
msh> bonjour clear {cname | location}

* cname
Reset the computer name. The default computer name will be displayed
when the computer is restarted.

* Jocation
Reset the location information. The previous location information will be deleted.
« Interface configuration
msh> bonjour linklocal “interface_name”

e If many types of interface are installed, configure the interface that com-
municates with linklocal address.

* If you do not specify an interface, the Ethernet interface is automatically selected.
* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface Interface configured
ether Ethernet interface
wlan IEEE 802.11b interface

« Setting IPP-SSL Printing
msh> bonjour ippport {ipp | ssl}

o IfIPP-SSL Printing is set to ssl, the IPP port number will appear as 443, and
IPP-SSL printing can be performed with higher security.

o [If IPP-SSL Printing is set to ipp, the IPP port number will appear as 631.
Port 631 is the port for normal IPP printing.

devicename

Use the "devicename" command to display and change the printer name.

% View settings

msh> devicename

% Printer name configuration
msh> devicename name “string”
* Enter a printer name using up to 31 alphanumeric characters.
* Set single names for each printer.

«» Printer name initialization
msh> devicename clear name

* Reset the printer name to its default.
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dhcp

Use the "dhcp" command to configure DHCP settings.

% View settings
The following command displays the current DHCP settings.
msh> dhcp

« Configuration
You can configure DHCP.
msh> dhcp “interface_ name” {on | off}
* C(lick {on} to enable dhcp. Click {off} to disable DHCP.

e [f the DNS server address and domain name are obtained from DHCP, be
sure to click {on}.

¢ wlan can be specified only when the IEEE 802.11 interface is installed.

Interface name Interface configured
ether Ethernet interface
wlan IEEE 802.11 interface

% Current interface priority configuration display
msh> dhcp priority

% Interface priority configuration
msh> dhcp priority “interface_ name”
* You can select which interface has DHCP parameter priority.
* Priority settings are available when multiple interfaces are installed.

« DNS server address selection
msh> dhcp dnsaddr {dhcp | static}

* Specify whether to obtain the DNS server address from the DHCP server
or use the address set by a user.

* To obtain the DNS server address from the DHCP server, specify "dhcp".
To use the address set by a user, specify "static".

< Domain name selection
msh> dhcp domainname {dhcp | static}

* Specify whether to obtain the domain name from the DNS server or use the
domain name set by a user.

* To obtain the domain name from the DHCP server, specify "dhcp". To use
the domain name set by a user, specify "static".
A Reference
p-121 “Using DHCP”
p-69 “dns”
p-70 “domainname” 67
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diprint

The direct printing port enables direct printing from a network-connected com-
puter.

Use the “diprint” command to change direct printing port settings.

% View settings

R
*o*

R
**

The following command displays the current direct printing port settings:

msh> diprint
Example output:

port 9100
timeout=300(sec)
bidirect on

con multi

apl async

¢ The “port” specifies the port number of the direct printing port.

* The “bidirect” setting indicates whether the direct printing port is bidirec-
tional or not.

Setting timeout

msh> diprint timeout [30~65535]

* You can specify the timeout interval to use when the printer is expecting
data from the network.

e The default is 300 seconds.

Specifying the number of concurrent connections
msh> diprint con {multi | single}

¢ The above command specifies the number of concurrent diprint connections.
Specify “multi” for multiple connections or “single” for a single connection.

e The default is “multi”.
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dns

Use the “dns” command to configure or display DNS (Domain Name System)
settings.

% View settings
The following command displays current DNS settings:
msh> dns

% IPv4 DNS server configuration
The following command enables or disables the IPv4 DNS server address:

msh> dns “number” server “server address”
The following command displays a configuration using the IP address
192.168.15.16 on a DNS 1 server:

msh> dns 1 server 192.168.15.16

* You can register IPv4 DNS Server address.

* You can register up to three IPv4 DNS server numbers.

* You cannot use “255.255.255.255” as the DNS server address.

« IPv6 DNS server configuration
The following command enables or disables the IPv4 DNS server address:

msh> dns “number” server6 “server address”
* You can register IPv6 DNS Server address.

* You can register up to three IPv6 DNS server numbers.

+ Dynamic DNS function setting
msh> dns “interface_name” ddns {on|off}
* You can set the dynamic DNS function "active" or "inactive".
e {on} means "active" and {off} means "inactive".

* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet interface
wlan IEEE 802.11b interface

% Specifying the record overlap operation
msh> dns overlap {update|add}
* You can specify operations performed when records overlap.
e update
To delete old records and register new records.
e add
To add new records and store the old records.

¢ When CNAME overlaps, it is always changed, irrespective of settings.
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+« CNAME registration
msh> dns cname {on|off}
* You can specify whether to register CNAME.
e {on} means "active" and {off} means "inactive".

* The CNAME registered is the default name beginning with rnp. CNAME
cannot be changed.

% A records registration
E msh> dns arecord {dhcp|own}
¢ {dhcp}
You can specify the method of registering an A record when the dynamic
DNS function is enabled and DHCP is used.

e {own}
To register an A record using the printer as the DNS client.
The DNS server address and the domain name already designated are
used for the registration.

« Record updating interval settings
msh> dns interval “time”

* You can specify the interval after which records are updated when using
the dynamic DNS function.

* The updating interval is specified hourly. It can be entered between 1 and
255 hours.

e The default is 24 hours.

domainname

Use the "domainname" command to display or configure the domain name settings.
You can configure the Ethernet interface, or IEEE 802.11b interface.

% View settings
The following command displays the current domain name:
msh> domainname

% Interface domain configuration
msh> domainname “interface_name”

+ Setting the Domain Name
msh> domainname “interface name” name “domain name”
* A domain name can be entered using up to 63 alphanumeric characters.
e The Ethernet interface and IEEE 802.11b interface will have the same domain name.
* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface Interface set
ether Ethernet interface
wlan IEEE 802.11b interface

% Deleting the Domain Name
70 msh> domainname “interface_ name” clear name
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help

Use the "help" command to display the available command list and the procedures
for using those commands.

% Command list display
msh> help

+ Display of procedure for using commands

msh> help “command name”

hosthame

Use the “hostname” command to change the printer name.

+« View settings

msh> hostname

« IPv4 Configuration
msh> hostname “interface name ” “printer name”
* Enter the printer name using up to 63 alphanumeric characters.

* You cannot use a printer name beginning “RNP” (in either upper or lower
case).

* The Ethernet interface and IEEE 802.11b interface will have the same printer
name.

* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet interface
wlan IEEE 802.11b interface

+ Initializing the printer name for each interface

msh>hostname “interface_name” clear name
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ifconfig

Use the "ifconfig" command to view and configure TCP/IP (IP address, subnet
mask, broadcast address, default gateway address) for the printer.

+« View settings
msh> ifconfig

% IPv4 Configuration
msh> ifconfig “interface_name” “parameter” “address”
e If youdid not enter an interface name, it is automatically set to the Ethernet interface.
* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet Interface
wlan IEEE 802.11b Interface

The following explains how to configure an IPv4 address 192.168.15.16 on
Ethernet interface.

msh> ifconfig ether 192.168.15.16

Y
**

IPv6 Configuration

msh> ifconfig ether inet6 interface_name ” “printer name”
The following explains how to configure a IPv6 address to 2001:DB8::100 with
prefix length 64 on the Ethernet interface.

msh> ifconfig ether inet6 2001:DB8::100 64

+« Netmask configuration

msh> ifconfig “interface_name” netmask “address”
The following explains how to configure a subnet mask 255.255.255.0 on Ethernet
interface.

msh> ifconfig ether netmask 255.255.255.0

% Broadcast address configuration
msh> ifconfig “interface_name” broadcast “address”

« Changing the Interface
msh> ifconfig “interface” up
* You can specify either the Ethernet interface or IEEE 802.11b interface
when using the optional IEEE 802.11b interface unit.
& Note
O To get the above addresses, contact your network administrator.
O Use the default configuration if you cannot obtain setting addresses.

O The IP address, subnet mask and broadcast address are the same as that for
the ethernet interface and IEEE 802.11b interface.

O TCP/IP configuration is the same for both Ethernet and IEEE 802.11 interface.
If interfaces are changed, the new interface inherits the configuration.

O Use "0x" as the initial two letters of a hexadecimal address.
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info

Use the "info" command to display printer information such as paper tray, output
tray, and printer language.

+ Printer information display

msh> info

A Reference
p-94 “Getting Printer Information over the Network”

ipp

Use the “ipp” command to view and configure IPP settings.

% Viewing settings
The following command displays the current IPP settings:
msh> ipp

% IPP timeout configuration
Specify how many seconds the computer waits before canceling an interrupted
print job. The time can be entered between 30 to 65535 seconds.

msh> ipp timeout [30 - 65535]

« IPP user authorization configuration

Use IPP user authorization to restrict users to print with IPP. The default is
/loff”,

msh> ipp auth {basic|digest|off}
¢ User authorization settings are “basic” and “digest”.

* If user authorization is specified, register a user name. You can register up
to 10 users.

+ IPP user configuration
Configure IPP users according to the following messages:

msh> ipp user
The following message appears:

msh> Input user number (1 to 10):
Enter the number, user name, and password.

msh> IPP user name:userl
msh> IPP password:****x**
After configuring the settings, the following message appears:

User configuration changed.
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ipv6

Use the “ipv6” command to display and configure IPv6 settings.

% View Setting

msh> ipvé

% |Pv6 stateless address

msh> ipv6é stateless {on | off}

If “on” is selected, IPv6 requests information required for maintaining state-
ful connection to the router for as long as the printer power is turned on. This
setting allows information from the router to be obtained constantly, and pe-
riodically refreshes the effective period of the stateless address.

Ipr

Use the “lpr” command to view and configure LPR settings.

% View Setting
msh> lpr

% Checking host name when deleting the job

msh> lpr chkhost {on|off}

If “on” is selected, you can delete print jobs only from the IP address of the
host that sent the print job. If LPR is disabled, you can also delete print jobs
sent from IP addresses other than that of the host.

<+ Printer Error Detection Function

lpr prnerrchk {on|off}
If you set this to “on”, the printer stops receiving data and will wait until the
error is resolved before continuing processing a job.
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netware

Use the “netware” command to view and configure the NetWare settings such
as the print server name or file server name.

% Netware Printer Server Names
msh> netware pname character string
* Enter the NetWare print server name using up to 47 characters.

+ Netware File Server Names
msh> netware fname character string
¢ Enter the NetWare file server name using up to 47 characters.

% Encap type
msh> netware encap {802.3|802.2|snap|ethernet2|auto}

< Remote Printer Number
msh> netware rnum {0-254}

< Timeout
msh> netware timeout {3-255}

< Printer server mode

msh> netware mode pserver
msh> netware mode ps

% Remote printer mode

msh> netware mode rprinter
msh> netware mode rp

% NDS context name
msh> netware context character string

< SAP interval
msh> netware “sap_ interval”

% Setting login mode for file server
msh> netware login server

+ Setting login mode for NDS tree
msh> netware login tree

% Setting login mode for NDS tree name
msh> netware tree “NDS name”

+ File transfer protocol
msh> netware trans {ipvdpri|ipxpri|ipv4|ipx}
* If you do not specify the protocol, the current setting is displayed.

Protocol Set Protocol
ipvépri IPv4+IPX(IPv4)
ipxpri IPv4+IPX(IPX)
ipv4 IPv4
ipx IPX 75
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passwd

Use the “passwd” command to change the remote maintenance password.

% Changing the Password
msh> passwd
¢ Enter the current password.
¢ Enter the new password.
* Renter the new password to confirm it.

% Changing the Password of the administrators using the Supervisor
msh> passwd {Administrator ID}
You can delete the administrator password or set up a new one.
¢ Enter the new password.
* Renter the new password to confirm it.

& Note

O Be sure not to forget or lose the password.

O The password can be entered using up to 32 alphanumeric characters. Passwords
are case-sensitive. For example, “R” is not the same as “r”.

pathmtu

Use the “pathmtu” command to display and configure the PathMTU Discovery
service function.

% View settings
msh> pathmtu

« Configuration
msh> pathmtu {on|off}
* The default is “on”.
* If the MTU size of the sent data is larger than the router's MTU, the router will

declare it impassable, and communication will fail. If this happens, selecting the
“pathmtu” to “off” optimizes the MTU size and prevents data output failure.

* Depending on the environment, information might not be obtained from the rout-
er, and communication will fail. If this happens, select the “pathmtu” to “oft”.

prnlog

Use the “prnlog” command to obtain printer log information.
+ Print logs display
msh> prnlog
* Display previous print jobs.
msh> prnlog “ID Number”
¢ Specity the ID number of the displayed print log information to display ad-
ditional details about a print job.
A Reference
p-94 “Getting Printer Information over the Network”.
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route

Use the “route” command to view and control the routing table.

% Specified route information display
msh> route get “destination”
¢ Specify the IPv4 address to destination.
“0.0.0.0” cannot be specified as destination address.

R
**

Enabling/disabling specified IPv4 destination
msh> route active {host|net} “destination” {on | off}
* You can turn the specified destination on or off. Host becomes the default setting.

+« Adding IPv4 Routing Table
msh> route add {host|net} “destination” “gateway”
* Adds a host or network route to “destination”, and a gateway address to
“gateway” in the table.
* Specify the IPv4 address to destination and gateway.
* Host becomes the default setting.

+ Setting the Default IPv4 Gateway

msh> route add default “gateway”

% Deleting specified IPv4 destination from Routing Table
msh> route delete {host|net} “destination”
* Host becomes the default setting.
¢ [Pv4 address of destination can be specified.

+ Setting IPv6 Default Gateway
msh> route add6é default gateway

% Adding a specified IPv6 destination to Routing Table
msh> route addé {destination} prefixlen gateway
* Specify the IPv6 address to destination and gateway.

+ Deleting a specified IPv6 destination from Routing Table
msh> route delete6 {destination} prefixlen
¢ Specify the IPv6 address to destination and gateway.

R
**

Display information about a specified IPv6 route information
msh> route get6 {destination}
* Specify the IPv6 address to destination and gateway.

 Enabling/disabling a specified IPv6 destination
msh> route active6 {destination} prefixlen {on | off}

+ Route initialization
msh> route flush

4 Note

O The maximum number of IPv4 routing tables is 16.

O The maximum number of IPv6 routing tables is 2.

O Seta gateway address when communicating with devices on an external network.

O The same gateway address is shared by all interfaces.

O “Prefixlen” is a number between 1 and 128. 77
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set

Use the "set" command to set the protocol information display "active" or "inactive".
% View settings

The following command displays protocol information (active/inactive).

msh> set ipv4

msh> set ipvé6

msh> set appletalk

msh> set netware

msh> set smb

msh> set protocol

* When protocol is specified, information about TCP/IP, AppleTalk, Netware,
and SMB appears.

msh> set lpr
msh> set 1lpré6
msh> set ftp
msh> set ftp6
msh> set rsh
msh> set rshé
msh> set diprint
msh> set diprinté
msh> set web
msh> set snmp
msh> set ssl
msh> set ssl6
msh> set nrs
msh> set rfu
msh> set rfué6
msh> set ipp
msh> set ipp6
msh> set http
msh> set httpé
msh> set bonjour
msh> set nbt
msh> set ssdp
msh> set ssh
msh> set sftp
msh> set sftpé6
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« Configuration

* Enter “up”to enable protocol, and enter “down” to disable protocol.
You can set the protocol to "active" or "inactive".

msh> set ipv4 {up | down}

¢ If you disable IPv4, you cannot use remote access after logging off. If you did
this by mistake, you can use the control panel to enable remote access via IPv4.

* Disabling IPv4 also disables lpr, ftp, rsh, diprint, web, snmp, ssl, ipp, http,
bonjour, and sftp

msh> set ipvé {up | down}

e If you disable IPv6, you cannot use remote access after logging off. If you did
this by mistake, you can use the control panel to enable remote access via IPv6.

* Disabling IPv6 also disables Ipr6, ftp6, rshé, diprinté, ssl6, ipp6, http6, and sftp6.

msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>

set
set
set
set
set
set
set
set
set
set
set
set
set
set
set

appletalk {up | down}
netware {up | down}
smb {up | down}

lpr {up | down}

lpr6 {up | down}

ftp {up | down}

ftp6 {up | down}

rsh {up | down}

rsh6 {up | down}
diprint {up | down}
diprint6 {up | down}
web {up | down}

snmp {up | down}

ssl {up | down}

ssl6 {up | down}

o If Secured Sockets Layer (SSL, an encryption protocol) function is not
available for the printer, you cannot use the function by enabling it.

msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>

set
set
set
set
set
set
set
set
set
set
set
set
set

nrs {up | down}
rfu {up | down}
rfué {up | down}
ipp {up | down}
ipp6 {up | down}
http {up | down}
http6 {up | down}
bonjour {up | down}
ssh {up | down}
ssdp {up | down}
nbt {up | down}
sftp {up | down}
sftp6 {up | down}
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show

Use the "show" command to display network interface board configuration settings.

% View settings
msh> show
e If"-p"is added, you can view settings one by one.

/O Reference
p-100 “Configuring the Network Interface Board”

slp

Use “slp” command to view and configure SLP settings.

msh> slp ttl “ttl_val”

* You can search the NetWare server using SLP in the PurelP environment of
NetWare 5/5.1. Using the "slp" command, you can configure the value of TTL
which can be used by SLP multicast packet.

* The default value of TTL is 1. A search is executed only within a local seg-
ment. If the router does not support multicast, the settings are not available
even if the TTL value is increased.

* The acceptable TTL value is between 1 and 255.

smb

Use the “smb” command to configure or delete the computer or workgroup
name for SMB.
« Computer Name settings
msh> smb comp “computer name”
¢ Set computer name using up to 15 characters. Names beginning with
"RNP" or "rnp" cannot be entered.
% Working Group Name settings
msh> smb group “work group name”
¢ Set workgroup name using up to 15 characters
< Comment settings
msh> smb comment “comment”
* Set comment using up to 31 characters.
% Notify print job completion
msh> smb notif {on | off}
* To notify print job completion, specify “on”. Otherwise, specify “off”
% Deleting Computer Name
msh> smb clear comp
Deleting Group Name
msh> smb clear group
+ Deleting Comment
msh> smb clear comment
+ View Protocol
msh> smb protocol

R
**
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snmp

Use the “snmp” command to display and edit SNMP configuration settings such
as the community name.

% View settings

msh> snmp

¢ Default access settings 1 is as follows:
Community name:public
IPv4 address:0.0.0.0
IPv6 address::
IPX address:00000000:000000000000
Access type:read-only
Effective Protocol:IPv4/IPv6/IPX

* Default access settings 2 is as follows:
Community name:admin
IPv4 address:0.0.0.0
IPv6 address::
IPX address:00000000:000000000000
Access type:read-write
Effective Protocol:IPv4/IPv6/IPX

e If"-p"is added, you can view settings one by one.
* To display the current community, specify its registration number.

% Display

msh> snmp ?

% Community name configuration
msh> snmp “number” name “community name”
* You can configure ten SNMP access settings numbered 1-10.

* The printer cannot be accessed from SmartDeviceMonitor for Admin or
SmartDeviceMonitor for Client if “public” is not registered in numbers 1-10.
When changing the community name, use SmartDeviceMonitor for Admin
and SNMP Setup Tool to correspond with printer settings.

¢ The community name can be entered using up to 15 characters.

+ Deleting community name

msh> snmp “number” clear name
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Access type configuration

msh> snmp “number” type “access_type”

Access type Type of access permission
no not accessible
read read only
write read and write
trap user is notified of trapmessages

Protocol configuration
msh> snmp {ipv4|ipvé|ipx} {on|off}

¢ Use the following command to set protocols "active" or "inactive": If you
set a protocol "inactive", all access settings for that protocol are disabled.

¢ Specify "ipv4" for IPv4, "ipv6" for IPv6, or "ipx" for IPX/SPX.
e {on} means "active" and {off} means "inactive".
¢ All protocols cannot be turned off concurrently.

Configuration of protocol for each registration number
msh> snmp “number” active {ipv4|ipv6|ipx} {on|off}

* To change the protocol of access settings, use the following command. How-
ever, if you have disabled a protocol with the above command, activating it
here has no effect.

Access configuration
msh> snmp “number” {ipv4|ipv6|ipx} “address”
* You can configure a host address according to the protocol used.

* The network interface board accepts requests only from hosts that have
IPv4, IPv6, and IPX addresses with access types of "read-only" or "read-
write". Enter “0” to have network interface board accept requests from any
host without requiring a specific type of access.

* Enter a host address to deliver "trap" access type information to.

* To specify IPv4 or IPv6, enter "ipv4" or "ipv6" followed by a space, and
then the IPv4 or IPv6 address.

* Tospecify IPX/SPX, enter "ipx" followed by a space, the IPX address followed
by a decimal, and then the MAC address of the network interface board.

sysLocation configuration

msh> snmp location

Deleting sysLocation

msh> snmp clear location

sysContact setting

msh> snmp contact
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+ Deleting sysContact

msh> snmp clear contact

< SNMP v1v2 function configuration
msh> snmp vliv2 {on|off}

* Specify "on" to enable, and "off" to disable.

% SNMP v3 function configuration

msh> snmp v3 {on|off}
* Specify "on" to enable, and "off" to disable.

% SNMP TRAP configuration

msh> snmp trap {vl|v2|v3} {on|off}
* Specify "on" to enable, and "off" to disable.

+« Remote Configuration Authorization configuration
msh> snmp remote {on | off}
* Specify "on" to enable, and "off" to disable the SNMP v1v2 setting.

% SNMP v3 TRAP configuration display

msh> snmp v3trap
msh> snmp v3trap {1-5}
¢ If anumber from 1-5 is entered, settings are displayed for that number only.

« Configuring a sending address for SNMP v3 TRAP
msh> snmp v3trap {1-5} {ipv4|ipvé6|ipx} “address”

« Configuring a sending protocol for SNMP v3 TRAP
msh> snmp v3trap {1-5} active {ipv4|ipv6|ipx} {on|off}

% Configuring a user account for SNMP v3 TRAP
msh> snmp v3trap {1-5} account “account_name”

¢ Enter an account name using up to 32 alphanumeric characters.

% Deleting an SNMP v3 TRAP user account

msh> snmp v3trap {1-5} clear account

% Configuring an SNMP v3 encryption algorithm
msh> snmp v3auth {md5|shal}

% Configuring SNMP v3 encryption
msh> snmp v3priv {auto|on}
* Set "auto" for automatic encryption configuration
* Set "on" for mandatory encryption configuration.
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sntp

The printer clock can be synchronized with a NTP server clock using Simple Net-
work Time Protocol (SNTP). Use the "sntp" command to change SNTP settings.
% View settings

msh> sntp

% NTP server address configuration
You can specify the IP address of the NTP server.

msh> sntp server “IP_ address”

+ Interval configuration
msh> sntp interval “polling time”

* You can specify the interval at which the printer synchronizes with the op-
erator-specified NTP server. The default is 60 minutes.

¢ The interval can be entered from 0, or between 16 and 10,080 minutes.
¢ If you set 0, the printer synchronizes with the NTP server only when you
turn the printer on. After that, the printer does not synchronize with the
NTP server.
+ Time-zone configuration
msh> sntp timezone “+/-hour_ time”

* You can specify the time difference between the printer clock and NTP
server clock. The values are between -12:00 and +13:00.
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spoolsw

Use the “spoolsw” command to view and configure Job Spool settings.
You can only specify diprint, trap, lpr, ipp, ftp, sftp, and smb(TCP/IP) protocol.

* The “spoolsw” command for configuring Job Spool settings is available only
when the optional hard disk is installed.

« View settings
The Job Spool setting appears.
msh> spoolsw

« Job Spool setting
msh> spoolsw spool {on|off}

& Note
O Specify "on" to enable Job Spool, or "off" to disable it.

R
**

Resetting Job spool setting
msh> spoolsw clear job {on|off}

¢ When the printer power is cut during job spooling, this determines whether
to reprint the spooled job.

R
**

Protocol configuration

msh> spoolsw diprint {on|off}
msh> spoolsw lpr {on|off}
msh> spoolsw ipp {on|off}
msh> spoolsw smb {on|off}
msh> spoolsw ftp {on|off}
msh> spoolsw sftp {on|off}

* You can specify the settings for diprint, lpr, ipp, ftp, sftp, and smb.

ssdp

Use the “ssdp” command to view and configure SSDP settings.

% View settings

msh> ssdp

% Setting effective time
msh> ssdp profile {1801-86400}
The default is 10800 seconds.

% Advertise packet TTL settings

msh> ssdp ttl {1-255}
The default is 4.
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ssh

Use the “ssh” command to view and configure SSH settings.

% View settings

msh> ssh

«+ Data compression communication settings
msh> ssh compression {on | off}
The default is "on".

« SSH/SFTP communication port setting
msh> ssh port {22, 1024-65535}
The default is 22.

« SSH/SFTP communication timeout setting
msh> ssh timeout {0-65535}

The default is 300.

+« SSH/SFTP communication login timeout setting
msh> ssh logintimeout {0-65535}
The default is 300.

« Setting an open key for SSH/SFTP

msh> ssh genkey {512|768|1024} "character string"
Create an open key for SSH/SFTP communication.

Usable characters are ASCII 0x20-0x7e (32 bytes) other than "0".
The default key length is 1024, and the character string is blank.

% Deleting open key for ssh/sftp communication
msh> ssh delkey

& Note
O If you do not specify a character string, current setting is displayed.

status

Use the “status” command to display the printer status.
% view messages
msh> status

A Reference
p-94 “Current Printer Status”



Remote Maintenance by telnet

syslog

Use the “syslog” command to display the information stored in the printer's sys-
tem log.

% View message

msh> syslog

A Reference
p-106 “System Log Information”

upnp
Use the "upnp" command to display and configure the universal plug and play.

% Public URL display

msh> upnp url

% Public URL configuration
msh> upnp url "string"

* Enter the URL string in the character string.
+ Deleting Public URL

msh> upnp clear url
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web

Use the “web” command to display and configure parameters on Web Image Monitor.

% View Settings

msh> web

< URL Configuration
You can set URLs linked by clicking [URL] on Web Image Monitor.
Specify "1" or "2" for x as the number corresponding to the URL. Up to two
URLSs can be registered and specified.

msh> web url http://”"The URL or IP address you want to
register”/

% Resetting URLs registered as link destinations
msh> web x clear url

Specify "1" or "2" for x as the corresponding number to the URL.

% Link name configuration
You can enter the name for URL that appears on Web Image Monitor.
Specify "1" or "2" for x as the corresponding number to the link name.

msh> web name “Name you want to display”

+« Resetting URL names registered as link destinations
msh> web x clear name
Specify "1" or "2" for x as the number corresponding to the link name.

+ Help URL Configuration
You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.

msh> web help http://”Help URL or IP address”/help/

+ Resetting Help URL

msh> web clear help
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wiconfig

Use the "wiconfig" command to make settings for IEEE 802.11b.
% View settings
msh> wiconfig

« View IEEE 802.11b settings

msh> wiconfig cardinfo

o IfIEEE 802.11b is not working correctly, its information is not displayed.

« Configuration

msh> wiconfig “parameter”

Parameter Value configured

mode [ap | adhoc|802.11adhoc] You can set the infrastructure mode (ap), the 802.11 Ad
hoc mode (802.11adhoc), or the ad hoc mode (adhoc).

The default is ad hoc mode.

ssid “ID value” You can make settings for the SSID in the infrastruc-
ture mode.

Usable characters are ASCII 0x20-0x7e (32 bytes).
An SSID value is set automatically to the nearest ac-
cess point if no setting is made.

If no setting is made for the 802.11 ad hoc mode, the
same value as for the infrastructure mode or an ASSID
value is automatically set. The default is blank.

channel frequency “channel no.” | You can enable or disable the WEP function. To enable
the WEP function, specify [on]; to disable it, specify [off].

To start the WEP function, enter the correct WEP key.
The defaultis “11”.

key [ “key value” ] val [1121314] | You can specify the WEP key when entering in hexa-
decimal.

With a 64-bit WEP, you can use 10 digit hexadecimals.
With a 128-bit WEP, you can use 26 digit hexadecimals.

Up to four WEP keys can be registered. Specify the
number to be registered with “val”.

When a WEP is specified by key, the WEP specified by
key phrase is overwritten.

To use this function, set the same key number and
WEP key for all ports that transmit data to each other.
Put “Ox”on the front of WEP key.

You can omit the numbers with “val”. The key
number is set to 1 when making these omissions. The
default is blank.
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Parameter

Value configured

keyphrase [ “phrase” [ val [1121314]

You can specify the WEP key when entering in ASCII.
With a 64-bit WEP, you can use 10 digit hexadecimals.
With a 128-bit WEP, you can use 26 digit hexadecimals.

Up to four WEP keys can be registered. Specify the
number to be registered with “val”.

When a WEP is specified by key phrase, the WEP
specified by key is overwritten.

To use this function, set the same key number and
WEDP key for all ports that transmit data to each other.

You can omit the numbers with “val”. The key number
is set to 1 when making these omissions. The default is
blank.

encval [1121314]

You can specify which of the four WEP keys is used for
packet encoding. “1” is set if a number is not specified.

wepauth [open | shared]

You can set an authorization mode when using WEP.
The specified value and authorized mode are as follows:

open: open system authorized (default)

shared: shared key authorized rate

rate [auto | 11m | 5.5m | 2m | 1m]

You can set the IEEE 802.11b transmitting speed.

The speed you specify here is the speed at which data
is sent. You can receive data at any speed.

auto: automatically set (default)
11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m:2 Mbps fixed

1m: 1 Mbps fixed

security {none | wep |wpa}

You can specify the security mode.
none: No encryption (default)
wep: WEP encryption

wpa: WPA encryption

wpaenc {tkip | ccmp}

You can specify WPA encryption key when using WPA
encryption.

tkip: TKIP
ccmp: CCMP (AES) (default)

wpaauth {wpapsk | wpa | wpa2psk
| wpa2}

You can specify the WPA authentication mode when
using WPA encryption.

wpapsk: WPA-PSK authentication (default)
wpa: WPA authentication

wpa2psk: WPA2-PSK authentication

wpa2: WPA2 authentication

psk "character string"

You can specify the Pre-Shared key.
Usable characters: ASCII 0x20-0x7e (8 to 63 bytes).
The default is blank.
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Parameter

Value configured

eap {tls | ttls | leap | peap} {chap | msc-
hap Imschapv2 | pap Imd5 | tls}

You can specify the EAP authentication type.

tls: EAP-TLS (default)

ttls: EAP-TTLS

leap: LEAP

peap: PEAP

chap, mschap, mschapv2, pap, md5, or tls are settings

for the phase 2 method, and must be set when using
EAP-TTLS or PEAP.

Do not make these settings when using other EAP au-
thentication types.

If you select EAP-TTLS, you can select chap, mschap,
mschapv2, pap, or mdb.

If you select PEAP, you can select mschapv?2 or tls.

username "character string”

You can specify the login user name for the Radius
server.

Usable characters: ASCII 0x20-0x7e (31 bytes) other
than "@". The default is blank.

username? "character string"

You can specify the phase 2 username for EAP-TTLS/
PEAP phase 2 authentication.

Usable characters: ASCII 0x20-0x7e (31 bytes) other
than "@". The default is blank.

domain "character string"

You can specify the login domain name for the Radius
server.

Usable characters: ASCII0x20-0x7e (31 bytes) other
than "@". The default is blank.

password "character string"

You can specify the login password for the Radius
server.

Usable characters: ASCII 0x20-0x7e (128 bytes). The
default is blank.

srvcert {on | off}

You can set the server certificate. The default is "off".

imca {on | off}

You can enable or disable the certificate when the in-
termediate certificate authority is present. The default
is "off".

srvid "character string"

You can set the server ID and subdomain of the certif-
icate server.
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wins

Use the "wins" command to configure WINS server settings.

% Viewing settings

msh> wins

E e If the IPv4 address obtained from DHCP differs from the WINS IPv4 address,

the DHCP address is the valid address.

« Configuration
msh> wins “interface_name” {on | off}
e {on} means "active" and {off} means "inactive".
* Be sure to specify the interface.
* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet interface
wlan IEEE 802.11b interface

« Address configuration
Use the following command to configure a WINS server IP address:

msh> wins “interface name” {primary|secondary} “IP address”
¢ Use the “primary” command to configure a primary WINS server IP address.
 Use the "secondary" command to configure a secondary WINS server IP address.
* Do not use “255.255.255.255” as the IP address.

% NBT (NetBIOS over TCP/IP) Scope ID Selection
You can specify the NBT scope ID.

msh> wins “interface_ name” scope “scope ID”

* The scope ID can be entered using up to 31 alphanumeric characters.

* Be sure to specify the interface.

* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet interface
wlan IEEE 802.11b interface
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SNMP

The SNMP agent operating on UDP and IPX is incorporated into the built-in Eth-
ernet board and optional IEEE 802.11b interface unit of this printer.

Using the SNMP manager, you can get information about the printer.

iﬁklmportant

O If you changed the machine's community name, change the configuration of
the connected computer accordingly, using SNMP Setup Tool. For details, see
SNMP Setup Tool Help.

The default community names are [public] and [admin]. You can get MIB infor-
mation using these community names.

+ Start SNMP Setup Tool

e Windows 95/98/Me, Windows 2000, Windows NT 4.0:
Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [Programs] menu.
Click [SNMP Setup Tool].

e Windows XP:
Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [All Programs] menu.
Click [SNMP Setup Tool].

«+ Supported MIBs (SNMPv1/v2)
e MIB-II
¢ PrinterMIB
¢ HostResourceMIB
e RicohPrivateMIB

% Supported MIBs (SNMPv3)
e MIB-II
¢ PrinterMIB
¢ HostResourceMIB
¢ RicohPrivateMIB
e SNMP-FRAMEWORK-MIB
e SNMP-TARGET-MIB
e SNMP-NOTIFICATION-MIB
e SNMP-USER-BASED-SM-MIB
e SNMP-VIEW-BASED-ACM-MIB
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Getting Printer Information over the Network

This section explains details of each item displayed in the printer status and in-
formation.

This manual covers all models, and therefore contains functions and settings
that may not be available for your model.

Current Printer Status

The printer status can be checked using the following commands:
e UNIX: Use the "lpq" command and "rsh", "rcp"”, “ftp”, and "sftp" parameters.
* mshell: Use the "status" command.

Messages Description
Access Restricted The job was canceled because user have no authority.
Adjusting... The machine is initializing or calibrating.
Call Service Center There is a malfunction in the machine.
Canceled The job is reset.
Canceling Job... The job is being reset.

Cannot Eject Original Through | Cannot output prints to the Rear Paper Exit.

Card/Counter not inserted The machine is waiting for prepaid card or key.

Coin or amount not inserted The machine is waiting for coin to be inserted.

Coin/Key Counter not inserted | The machine is waiting for coin or key counter.

Configuring... Setting is being changed.

Cooling Down Fusing Unit... The fusing unit is cooling down.

Cover Open: Finisher Cover The cover of Finisher is open.

Data Size Error The data size error occurred.

Empty: Black Toner The black toner cartridge is almost empty.

Energy Saver Mode The machine is in Energy Save Mode.

Error An error has occurred.

Error: Address Book An error has occurred in the data of the address book.

Error: Command Transmission | An error has occurred in the machine.

Error: DIMM Value A memory error occurred.

Error: Ethernet Board An Ethernet board error has occurred.

Error: HDD Board A hard disk drive board error has occurred.

Error: Memory Switch A memory switch error has occurred.

Error: Optional Font An error has occurred in the font file of the machine.

Error: Parallel I/F Board An error has occurred in the parallel interface.
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Messages

Description

Error: PDL

An error has occurred in the page description language.

Error: Rem. Certificate Renewal

An error has occurred in the remote sever renewal.

Error: USB Interface

An error has occurred in the USB interface.

Error: Wireless Board

A wireless board error has occurred.

Error: Wireless Card

Wireless card is not inserted during start up, or the IEEE 802.11b
interface unit or the wireless card is taken out after start up .

Full: Hole Punch Receptacle

Punch Chip receptacle for hole punch is full.

Full: Waste Toner

Waste toner is full.

Hex Dump Mode

It is a hex dump mode.

In Use: Copier

The copier is being used.

In Use: Finisher

Other functions is using Finisher.

In Use: Input Tray

Other functions is using the input tray.

Independent-supplier Toner

Toner that is not recommended is set.

Key Card not inserted

The machine is waiting for key card to be inserted.

Key Card/Counter not inserted

The machine is waiting for key card or key counter to be inserted.

Key Counter not inserted

The machine is waiting for key counter to be left in it.

Loading Toner...

Toner is being supplied.

Low: Black Toner

The black toner cartridge is not set correctly, or toner is almost
running out.

Low: Toner

The toner cartridge is not set correctly, or toner is almost running out.

Malfunction: Finisher

There is a problem with the finisher.

Malfunction: Output Tray

There is a problem with the output tray.

Malfunction: Punch Unit

There is a problem with the punch unit.

Memory Low: Copy

Memory shortage has occurred while the copy was operating.

Memory Low: Data Storage

Memory shortage has occurred while the document was being
accumulated.

Memory Low: Scanning

Memory shortage has occurred while the scanner was working.

Miscellaneous Error

Other error has occurred.

Mismatch: Paper Size

Indicated paper tray does not contain paper of selected size.

Mismatch: Paper Size and Type

Indicated paper tray does not contain paper of selected size and type.

Mismatch: Paper Type

Indicated paper tray does not contain paper of selected type.

Near Replacing: Black PCU

Prepare the new black photoconductor unit.

Near Replacing: Develop. Unit K

Prepare the new development unit (black).

Near Replacing: Fusing Unit

Prepare the new fusing unit.

Nearly Full: Waste Toner

Waste toner bottle is nearly full.

No Paper: Selected Tray

There is no paper in specified tray.

Not Detected: Black Toner

Black toner is not correctly set.
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Messages

Description

Not Detected: Develop. Unit (K)

The development unit (black) is not correctly set.

Not Detected: Finisher

Finisher is not correctly set.

Not Detected: Fusing Unit

The fusing unit is not correctly set.

Not Detected: Input Tray

The paper feed tray is not correctly set.

Not Detected: PCU (K)

The photoconductor unit (black) is not correctly set.

Not Detected: WasteToner Bottle

Waste toner bottle is not correctly set.

Offline

Printer is offline.

Operating Thermo-range Error

The machine is operating outside the permissible temperature range.

Panel Off Mode

The machine is in Panel-Off mode.

Panel Off Mode>>Printing ava.

The machine is in Control Panel-Off mode.

Paper in Finisher

The paper remains in Finisher.

Prepaid Card not inserted

The machine is waiting for prepaid card to be inserted.

Print Complete The print was completed.
Printing... Printing is in progress.
Processing Data is being processed.

Proxy Address/Port Incorrect

The proxy address and port setting is incorrect.

Proxy User/Password Incorrect

The proxy user name and password setting is incorrect.

Ready

The machine is ready to print.

Renewing Remote Certificate

The remote certificate is being renewed.

Replace Black PCU

It is time to replace the black photoconductor unit.

Replace Cleaning Web

It is time to replace the Cleaning Web.

Replace Develop. Unit

It is time to replace the development unit.

Replace Fusing Unit It is time to replace the fusing unit.

Replace PCU It is time to replace the photoconductor unit.

Retarding... Printing has stopped momentarily to allow printed sheets to dry.
SD Card Authentication failed | SD card authentication failed.

Skipped due to Error Skipped the error.

Storage Complete The storage is complete.

Storage Failed The storage has failed.

Supplies Order Call failed

The supply order call has failed.

Waiting for Job Suspension

The machine is waiting for Job Suspension.

Warming Up...

The machine is warming up.

4 Note

O For details about UNIX commands, see UNIX Supplement.

O Check the error contents that may be printed in the configuration page. For
details about printing a configuration page, see Printer Reference.
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Printer configuration

You can check the printer configuration using telnet.

This section explains the checking procedure for input/output tray and printer

language.

¢ UNIX: Use the "info" command and "rsh", "rcp", “ftp”, and "sftp" parameters.

e mshell: Use the "info" command.

« Input Tray

Item Description
No. ID number of the paper tray
Name Name of the paper tray
PaperSize Size of paper loaded in the paper tray
Status Current status of the paper tray
¢ Normal: Normal
¢ NolnputTray: No tray
¢ PaperEnd: No paper
« Output Tray
Item Description
No. ID number of the output tray
Name Name of the output tray
Status Current status of the output tray

¢ Normal: Normal

¢ PaperExist: Paper exist
¢ OverFlow: Paper is full
* Error: Other errors

« Printer Language

Item Description
No. ID number of the printer language used by the printer
Name Name of the printer language used in the printer
Version Version of the printer language
& Note

O For details about UNIX commands and parameters, see UNIX Supplement.
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Understanding the Displayed Information

This section explains how to read status information returned by the network in-
terface board.

Print Job Information

Use the following command to display print job information:
¢ UNIX: Use the "info" command and "rsh", "rcp", “ftp”, and "sftp" parameters.
e mshell: Use the "info" command.

Item Description
Rank Print job status.
e Active
Printing or preparing for printing.
¢ Waiting
Waiting to be transferred to the printer.
Owner Print request user name.
Job Print request number.
Files The name of the document.
Total Size The size of the data (spooled).
The default is 0 bytes.
& Note

O For details about UNIX commands and parameters, see UNIX Supplement.
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Print Log Information

This is a record of the most recent jobs printed.

Use the following command to display print log information:

¢ UNIX: Use the "prnlog" command and "rsh", "rcp", "ftp", and "sftp" parameters.
¢ telnet : Use the “prnlog” command.

Item Description
ID Print request ID.
User Print request user name.
Page Number of pages printed
Result Print Request Result

Communication Result

¢ OK
Print was completed normally. However, the print result may
not be as required due to printer problems.

* NG
Printing was not completed normally.

¢ Canceled
An "rcp", "rsh", or "lpr" command print request was canceled,
possibly due to the printing application. Not applicable to the

"ftp" or "rprinter" command.

Time Time the print requested was received.

Time of print request reception

User ID Printer driver-configured User ID.
Appears when the print request ID is specified.

JobName Name of the document for printing

Appears when the print request ID is specified.

& Note
O For details about UNIX commands and parameters, see UNIX Supplement.
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Configuring the Network Interface Board

Use the following command to display network interface board settings:
¢ telnet: Use the “show” command.

Item Description

Common
Mode
Protocol Up/Down Protocol Settings

AppleTalk
IPv4
IPv6
TCP/IP
Netware
SMB
Device Up/Down Device Settings
Parallel
USB
Ethernet interface
Syslog priority
NVRAM version
Device name
Comment
Location
Contact

Soft switch

AppleTalk AppleTalk settings
Mode
Net
Object
Type

Zone
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Item

Description

TCP/IP
Mode(IPv4)
Mode(IPv6)

ftp
lpr
rsh
telnet
diprint
web
http
ftpc
snmp
ipp
autonet
bonjour
ssl
nrs
rfu
nbt
ssdp
ssh
sftp
IPv4
DHCP
Address
Netmask
Broadcast
Gateway
IPv6
Stateless
Manual
Gateway
EncapType
Host name

DNS Domain

TCP/IP settings
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Item

Description

Access Control
IPv4
AccessEntry[X]
IPv6
AccessEntry[X]
Time server
Time Zone
Time server polling time
SYSLOG server
Home page URL1
Home page linknamel
Home page URL2
Home page linkname?2

Help page URL

Access Control settings

X can be set between 1 and 5.

X can be set between 1 and 5.

Time settings

Websys settings

Netware
EncapType
RPRINTER number
Print server name
File server name
Context name
Switch
Mode
NDS/Bindery
Packet negotiation
Login Mode
Print job timeout
Protocol
SAP interval time
NDS Tree Name

Transfer Protocol
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Item Description

SMB SMB settings
Switch
Mode
Direct print

Notification

Workgroup name
Computer name
Comment

Share name[1]

Protocol

IEEE 802.11b IEEE 802.11b settings
Host Name
Communication mode
SSID
Channel range
Channel
TX Rate
Security
WEP Authentication
WEP Encryption key number
WEP encryption
WEP Encryptionkeys [X] X can be set between 1 and 5.
WPA Encryption
WPA Authentication
Pre-Shared Key
User name
Domain name
EAP Type
Password
Phase 2 username
Phase 2 Method TTLS
Phase 2 Method PEAP
Server cert
IntermediateCA
Server ID
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Item Description

DNS DNS settings

IPv4
Server[X] X can be set between 1 and 3.

Selected IPv4 DNS Server

IPv6
Server[X] X can be set between 1 and 3.

Domain Name
ether

wlan

DDNS
ether

wlan

WINS WINS settings

ether
Primary WINS
Secondary WINS
wlan
Primary WINS
Secondary WINS

SSDP SSDP settings
UUID
Profile

TTL

UPnP UPnP settings
URL

Bonjour Bonjour (Redezvous) settings

Computer Name (cname)
Local Hostname<ether>
Local Hostname<wlan>
Location

Priority <diprint>

Priority <lpr>

Priority <ipp>

IP TTL

LinkLocal Route for Multil/F
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Item

Description

SNMP
SNMPv1v2
SNMPv3
protocol
v1Trap
v2Trap
v3Trap
SNMPv1v2 Remote Setting
SNMPv3 Privacy

SNMP settings

ssh
Compression
Port
TimeOut

Login TimeOut

ssh settings

AuthFree
IPv4
AuthFreeEntry[X]
IPv6
AuthFreeEntry[X]
Parallel
USB

Authfree settings

X can be set between 1 and 5.

X can be set between 1 and 5

LPR
Iprm check host

Certificate

Verification

Shell mode

Remote maintenance tool mode
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Message List

This is a list of messages that appear in the machine's system log. The system log
can be viewed using the "syslog" command.

System Log Information

Use the following command to display the system log information:

¢ UNIX: Use the "syslog" command and "rsh", "rcp", “ftp”, and "sftp" parameters.

¢ telnet: Use the “syslog” command.

Message

Problem and solutions

Access to NetWare server <file server name>
denied. Either there is no account for this print
server on the NetWare server or the password
was incorrect.

(In the print server mode) Login to the file
server failed. Make sure that the print server is
registered on the file server. If a password is
specified for the print server, delete it.

account is unavailable:

Same account name be used.

User account is disabled. This could be be-
cause it use the same account name as the ad-
ministrator account.

account is unavailable:

The authentication password is not set up.

User account is disabled. This could be be-
cause the authentication password is not set,
and only the encryption account is set.

account is unavailable:

encryption is impossible.

Encryption is not possible and account is disa-
bled. This could be because:

* Security option is not installed.
¢ Encryption password has not been specified.

add_sess_IPv4: bad trap <IPv4 address>com-
munity <community name>

The IPv4 address (0.0.0.0.) is unavailable when
the community access type is TRAP. Specify the
host IPv4 address for the TRAP destination.

add_sess_IPv6: bad trap <IPv6 address>com-
munity <community name>

The IPv6 address [::] is unavailable when the
community access type is TRAP. Specify the
host IPv6 address for the TRAP destination.

add_sess_IPv4: community<community
name> already defined.

The same community name already exists.
Use another community name.

add_sess_IPv6: community <community
name> already defined.

The same community name already exists.
Use another community name.

add_sess_IPX: bad trap<IPX address>commu-
nity <community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is
TRAP. Specify the host IPX address for the
TRAP destination.

add_sess_ipx: community <community-
name> already defined.

The same community name already exists.
Use another community name.

Attach FileServer= <file servername>

Connection to the file server as the nearest
server has been established.
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Message

Problem and solutions

Attach to print queue <print queue name>

(In the print server mode) Attached to the
print queue.

Authentication mode mismatch< SSID >

Authentication mode is different to the AP. The
required SSID is the SSID of the access point
connected to when in infrastructure mode.

centrod is disabled.

Communication via parallel connection is un-
available because centrod is disabled in the se-
curity mode.

Enable centrod in the security mode.

Cannot create service connection

(In the remote printer mode) Connection to the
file server has not been established. The
number of file server users may have exceeded
the maximum capacity of the file server.

Cannot find rprinter (<print server
name>/<printer number>)

The printer with the number displayed on the
print server does not exist. Make sure that the
printer number is registered on the print server.

Change IP address from DHCP Server.

The IP address changes when DHCP lease is re-
newed. To always assign the same IP address,
set a static IP address to the DHCP server.

child process exec error! (process name)

The network service failed to start. Turn the
printer off and then on. If this does not work,
contact your service or sales representative.

Client password rejected

The client's password was rejected. Check the
client password.

Client tls certificate rejected

The client's TLS certificate was rejected. Check
the certificate.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received from
the DHCP server.

Could not attach to FileServer<error number>

(In the remote printer mode) Connection to the
file server has not been established. The file
server has refused the connection. Check the
file server configuration.

Could not attach to PServer<print server>

(In the remote printer mode) Connection to the
print server has not been established. The
print server has refused the connection. Check
the print server configuration.

Current Interface Speed:xxxMbps

Speed of the network (10Mbps, 100 Mbps, or
1Gbps).

Current IP address <current IP address>

Current IPv4 address.

Current IPX address<IPX address>

Current IPX address

DHCEP lease time expired. DHCEP lease time has expired. The printer tries
to discover the DHCP server again. The IP ad-
dress until now becomes invalid.

DHCP server not found. The DHCP server was not found. Make sure

that the DHCP is on the network.
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Message

Problem and solutions

dhcpced start.

The DHCPCD service (dhcp client service) has
started.

Duplicate IP=<IP address>(from<MAC ad-
dress>).

The same IP address (IPv4 or IPv6 address)
was used. Each IP address (IPv4 or IPv6 ad-
dress) must be unique. Check the address of
the device indicated in [MAC address].

Established SPX Connection with PServ-
er,(RPSocket=<socketnumber>, con-
nID=<connection ID>)

(In the remote printer mode) Connection to the
print server has been established.

exiting

The Ipd service has ended and the system is
exiting the process.

Exit pserver

(In the print server mode) The print server
function is disabled because the necessary
print server settings have not been made.

Frametype =<frame type name>

The frame type name is configured to be used
on NetWare.

httpd start.

The httpd service has started.

IEEE 802.11b <communication mode> mode

Displays IEEE 802.11b communication mode.

inetd start.

The inetd service has started.

Interface (interface name): Duplicate IP Ad-
dress (IP address).

The same IP (IPv4 or IPv6) address was used.
Each IP address must be unique. Check the ad-
dress of the device indicated in [IP address].

< Interface > started with IP: < IP address >

IP address (IPv4 or IPv6 address) has been set
for the interface and is operating.

< Interface >: Subnet overlap.

The same IP address (IPv4 or IPv6 address)
and the subnet mask is used with other device.

IPP cancel-job: permission denied.

The printer could not authenticate the name of
the user attempting to cancel a job.

ipp disable.

Printing with ipp is disabled.

ipp enable.

Printing with ipp is enabled.

IPP job canceled. jobid=%d.

The spooled job was canceled due to error or
user request.

LeaseTime=<lease time>(sec), Renew-
Time=<renewtime>(sec).

The resource lease time received from the
DHCP server is displayed in [lease time] in
seconds. The renewal time is displayed in [re-
new time] in seconds.

Login to fileserver <file server name>
(<IPX IPv4 | IPv6>,<NDS | BIND-
ERY INDS | BINDERY>)

(In the print server mode) Login to the file
server is in the NDS or BINDERY mode.

Memory allocate error.

Data cannot be obtained.

Disconnect the USB cable, and then connect it.

Name registration success. WINS Server=<WINS
server address>NetBIOS Name=<NetBIOSname>

Name registration of <NetBIOS Name> to
<WINS server address> was successful.
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Message

Problem and solutions

Name registration success in Broadcast
name=<NetBIOS Name>

Name registration by Broadcast name of <Net-
BIOS Name> was successful.

Name registration failed. name=<NetBIOS
name>

Name registration of <NetBIOSName> failed.
Change to different NetBIOS name.

nbtd start.

The nbtd service has started.

nprinter start (Netware)

(In the remote printer mode) The NetWare
service has started.

nwstart start. (NetWare)

The service for NetWare protocol stack setting
has started.

Open log file <file name>

(In the print server mode) The specified log file
has been opened.

phy release file open failed.

Replacing the network interface board is required.
Contact your sales or service representative.

Print queue <print queue name> cannot be
serviced by printer 0, <print server name>

(In the print server mode) The print queue
cannot be established. Make sure that print
queue exists on the specified file server.

Print server <print servername>has no printer.

(In the print server mode) The printer is not as-
signed to the print server. Using NWadmin,
assign the printer, and then restart it.

print session full

No more print jobs can be accepted.

Printer <printer name> has no queue

(In the print server mode) The print queue is
not assigned to the printer. Using NWadmin,
assign the print queue to the printer, and then
restart it.

pserver start. (NetWare)

(In the print server mode) The NetWare serv-
ice has started.

Required file server (<file servername>) not
found

The required file server is not found.

received EAP Failure

EAP reception failed.

restarted.

The lpd service has started.

sap enable, saptype=<SAP type>, sapname=
<SAP name>

The SAP function has started. The SAP packet
is issued to advertise the service on the SAP ta-
ble on the NetWare server.

server identity invalid

The server ID is disabled. Check the server au-
thentication.

session IPv4 <community name> not defined.

The requested community name is not defined.

session IPv6 <community name> not defined.

The requested community name is not defined.

session <community name> already defined.

The requested community name is not defined.

session_ipx <community name> not defined.

The requested community name is not defined.

Set context to <NDS context name>

An NDS context name has been set.

smbd start. (NETBIOS)

The smbd service has started.
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Message

Problem and solutions

SMTPC: failed to get smtp server ip-address.

The SMTP server IP address could not be ob-
tained. This could be because:

* The specified DNS server could not be
found.

¢ No connection to the network has been es-
tablished.

® The specified DNS server could not be
found.

¢ An incorrect DNS server is specified.

¢ The specified SMTP server IP address
could not be found in the DNS server.

SMTPC: failed to connect smtp server. timeout.

Connection to the SMTP server failed due to
timeout. This could be because the specified
SMTP server name is incorrect, or no connec-
tion to the network has been established, or the
network configuration is incorrect, so there is
no response from the SMTP server. Check the
SMTP server name, or the network connection
and configuration.

SMTPC: refused connect by smtp server.

Connection to the SMTP server is denied. This
could be because server other than the SMTP
server has been specified, or the specified
SMTP server port number is incorrect. Check
the SMTP server name, port number, or the
SMTP server port number.

SMTPC: no smtp server. connection close.

Connection to the SMTP server failed due to
no response from SMTP. This could be be-
cause a server other than the SMTP server has
been specified, or the specified SMTP server
port number is incorrect. Check the SMTP
server name, port number, or the SMTP server
port number.

SMTPC: failed to connect smtp server.

Connection to the SMTP server failed. This
could be because no connection to the network
has been established, or the network configura-
tion is incorrect, so there is no response from the
SMTP server, or the specified SMTP server
name is incorrect, or the specified SMTP server
IP address could not be found in the DNS serv-
er, or a server other than the SMTP server has
been specified, or the specified SMTP server
port number is incorrect. Check the DNS Serv-
er's IP address and SMTP server's IP address, or
the SMTP server name and SMTP port number,
or the SMTP server's SMTP port number, or the
network connection and configuration.

SMTPC: username or password wasn’t cor-
rect. [response code] (information)

Connection to the SMTP server failed, because
the specified SMTP user name is incorrect, or
the specified SMTP password is incorrect.
Check the SMTP user name and password.
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Message

Problem and solutions

Snmp over IPv4 is ready

Communication over IPv4 with snmp is available.

Snmp over IPv6 is ready.

Communication over IPv6 with snmp is available.

Snmp over ipx is ready.

Communication over IPX with snmp is available.

snmpd start.

The snmpd service has started.

started. The direct print service has started.
Started. The bonjour (rendezvous) function is enabled.
terminated. The bonjour (rendezvous) function is disabled.

The print server received error <error number>
during attempt to log in to the network. Access
to the network was denied. Verify that the print
server name and password are correct.

Login to the file server failed. The print server
is not registered or a password is specified.
Register the print server without specifying a
password.

trap account is unavailable.

v3Trap cannot be sent. This could be because
the Trap destination account is different from
the account specified by the printer.

usbd is disable.

Plug and Play function and printing is disabled
because usbd is disabled in the security mode.

Enable usbd in the security mode.

WINS name registration: No response to server
<WINS server address>

There was no response from the WINS server.
Check the correct WINS server address is en-
tered. Alternatively, check the WINS server is
functioning properly.

WINS wrong scopelD=<Scope ID>

An invalid scope ID was used. Use a valid
scope ID.

wpa authentication Failed

WPA authentication failed. Check the WPA
configuration.

wpa authentication started

WPA authentication has started.

wpa IEEE802.1X started

WPA authentication has started.

wpa connecting to authenticator

WPA is connecting to authenticator.

wpa link up

WPA key exchange has finished, and commu-
nication has been terminated.

wpa probe response doesn’t have IE.

WPA probe response does not have IE.

wpa success authenticated

WPA authentication was successful.

wpa success key received

WPA key reception was successful.

wpa waiting for key

Waiting for WPA key.

wpasupd start

wpasupd has started.

wpasupd stop

wpasupd has ended.

& Note

O For details about UNIX commands and parameters, see UNIX Supplement.
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3. Special Operations under

Windows

Printing Files Directly from Windows

You can print files directly using Windows commands. For example, you can
print PostScript files for PostScript 3.

< Windows 95/98/Me

You can print files directly using ftp command.

% Windows 2000/XP, Windows Server 2003, Windows NT 4.0
You can print files directly using lpr, rcp ftp command.

Setup

Follow the procedure below to make network environment settings.

ﬂ Enable TCP/IP with the control panel, and then set up the printer’s network
environment about TCP/IP including IP addresses.

TCP/IP of the printer is set as default.

g Install a TCP/IP in Windows to set up the network environment.
Consult the network administrator for the local setting information.

B To print under Windows 2000/XP, Windows Server 2003, install “Printing
service for UNIX” as the network application. To print under Windows NT
4.0, install “Microsoft TCP/IP printing” as the network application.

p Reference
p-121 “Using DHCP”
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Using a Host Name Instead of an IPv4 Address

When a host name is defined, you can specify a printer by host name instead of
IP address. The host names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.

When setting the IPv4 address of a printer using DHCP

Use the printer name on the configuration page as the host name.

& Note
O For details about printing a configuration page, see General Setting Guide.

In other cases

Add the IP address and host name of the network printer to the hosts file on the
computer used for printing. Methods of addition vary depending on operating
systems.

Windows 95/98/Me

ﬂ Copy \WINDOWS\HOSTS.SAM to the same directory and name it “HOSTS”
with no extension.

ﬂ Open the " \WINDOWS\HOSTS" file created using memo pad files, for in-
stance.

B Add an IP address and host name to the hosts file using the following format:

192.168.15.16 host # NP

"192.168.15.16" is the IP address, "host" is the printer's host name, and "#NP"
is replaced by comments. Insert a space or tab between "192.168.15.16" and
"host", between "host" and "#NP" respectively, using one line for this format.

ﬂ Save the file.

Windows 2000/XP, Windows Server 2003, Windows NT 4.0

ﬂ Open the hosts file using memo pad files, for instance.
The hosts file is in the following folder:
\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS

"\WINNT" is the directory of the installation destination for Windows
2000/ XP, Windows Server 2003, and Windows NT 4.0.
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B) Add an 1Pv4 or IPv6 address and host name to the hosts file using the fol-
lowing format:

192.168.15.16 host # NP

"192.168.15.16" is the IPv4 address, "host" is the printer's host name, and "#NP"
is replaced by comments. Insert a space or tab between "192.168.15.16" and
"host", between "host" and "#NP" respectively, using one line for this format.

2001:DB::100 host # NP

"2001:DB::100" is the IPv6 address, "host" is the printer's host name, and "#NP"
is replaced by comments. Insert a space or tab between "2001:DB::100" and
"host", between "host" and "#NP" respectively, using one line for this format.

B Save the file.

& Note

O When using a host name under Windows Server 2003 with IPv6 protocol,
perform host name resolution using an external DNS server. The host file
cannot be used.
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Printing Commands

/AT

The following explains printing operations using the “lpr”, “rcp”, and “ftp”
commands.

Enter commands using the command prompt window. The location of the com-
mand prompts varies depending on operating systems:

e Windows 95/98
[Start] - [Programs] - [MS-DOS Prompt]
e Windows Me
[Start] - [Programs] - [Accessories] - [MS-DOS Prompt]
e Windows 2000
[Start] - [Programs] - [Accessories] - [Command Prompt]
e Windows XP, Windows Server 2003
[Start] - [All Programs] - [Accessories] - [Command Prompt]

e Windows NT 4.0
[Start] - [Programs] - [Command Prompt]

& Note
0O Match the data format of the file to be printed with the emulation mode of the
printer.

O If the message "print requests full" appears, no print jobs can be accepted. Try
again when sessions end. For each command, the amount of possible sessions
is indicated as follows:

¢ lpr: 5 (When the spool printing function is available: 10)
* rcp, rsh: 5
o ftp:3
O Enter the file name in a format including the path from the directory execut-
ing commands.

O The “option” specified in a command is an intrinsic printer option and its syn-
tax is similar to printing from UNIX. For details, see UNIX Supplement.

Ipr

% When specifying a printer by IP address
c:> lpr -Sprinter's IP address [-Poption] [-o0l] \pass name\file name

% When using a host name instead of an IP address

c:> lpr -Sprinter's host name [-Poption] [-0l] \pass name\file name
When printing a binary file, add the "-ol" option (lowercase O, and lowercase L).

When using a printer with the host name "host" to print a PostScript file named
"file 1" located in the "C:\PRINT" directory, the command line is as follows:

c:> lpr -Shost -Pfiletype=RPS -0l C:\PRINT\filel
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rcp

First, register the printer's host name in the hosts file.
c:> rcp [-b] \pass name\file name [pass name\file name...]
printer's host name: [option]

& Note
O In file names, "™" and "?" can be used as wild cards.

O When printing a binary file, add the “-b” option.

When using a printer with the host name "host" to print a PostScript file named "file
1" or "file 2" located in the "C:\PRINT" directory, the command line is as follows:

c:> rcp -b C:\PRINT\filel C:\PRINT\file2 host:filetype=RPS

p Reference
p-114 “Using a Host Name Instead of an IPv4 Address”

ftp

Use the "put" or "mput" command according to the number of files to be printed.

% When one file is printed

ftp> put \pass name\file name [option]

« When multiple files are printed
ftp> mput \pass name\file name [\pass name\file name...] [option]

Follow the procedure below to print using the "ftp" command.

ﬂ Formulate the printer's IP address or the host name of the hosts file printer
as an argument and use the "ftp" command.

% ftp printer's IP address

ﬂ Enter the user name and password, and then press the [ Enter] key.

For details about the user name and password, consult your network admin-
istrator.

User:
Password:

When user authentication is set, enter a login user name and password.

B When printing a binary file, set the file mode to binary.
ftp> bin
When printing a binary file in ASCII mode, print may not come out correctly.
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ﬂ Specify files to be printed.

The following shows the examples of printing a PostScript file named "file 1"
in the "C:\PRINT" directory and printing file 1 and file 2.

ftp> put C:\PRINT\filel filetype=RPS
ftp> mput C:\PRINT\filel C:\PRINT\file2

B Quit ftp.
ftp> bye
& Note

g “=",“","“ ", and “;”cannot be used for filenames. File names will be read
as option strings.

O For “mput” command, option can not be defined.
O For “mput” command, “*” and “?” can be used as wild cards in file names.
O When printing a binary file in ASCII mode, print may not come out correctly.



4. Appendix

When Using Windows Terminal Service /
MetaFrame

The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment

The following operating systems and MetaFrame versions are supported.

< Windows NT Server 4.0 Terminal Server Edition
e MetaFrame 1.8 SP3 / FR1+SP3 / SP4
e MetaFrame XP 1.0 SP1 / SP2 / FR1

% Windows 2000 Server / Advanced Server
e MetaFrame 1.8 SP3 / FR1+SP3 / SP4
e MetaFrame XP 1.0 SP1 / SP2 / SP3 / FR1 / FR2 / FR3
¢ MetaFrame Presentation Server 3.0
¢ (itrix Presentation Server 4.0

« Windows 2003 Server
e MetaFrame XP 1.0 FR3
e MetaFrame Presentation Server 3.0
¢ (itrix Presentation Server 4.0

Supported Printer Drivers

% When Windows Terminal Service is operating
* PostScript 3
e RPCS drivers

& Note

O Some RPCS printer driver functions do not work if Windows Terminal Service
is installed.
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Appendix

Limitations

The following limitations apply to the Windows Terminal Service environment.

These limitations are built in Windows Terminal Service or MetaFrame.

R
**

2
**

Windows Terminal Service

In the Windows Terminal Service environment, some of the printer driver’s
functions is unavailable. In an environment where Windows Terminal Service
is installed, some of the printer driver’s functions is unavailable, even if any
function of Windows Terminal Service is not used. When you install SmartDe-
viceMonitor for Client in an environment where the Terminal Service is run-
ning on a Windows NT Server 4.0 Terminal Server Edition or the Windows
2000 Server family computer, be sure to install it using the install mode. The fol-
lowing are the two methods of installation using the install mode:

@® Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor
for Client.

@ Enter the following command in the MS-DOS command prompt:
To quit the install mode, enter the following command in the MS-DOS command
prompt.

MetaFrame's [Auto-creating client printers]

Using [Auto-creating client printers] can select a logical printer created by copying
the client's local printer data to the MetaFrame server. We strongly recommend
testing this function in your network environment before using it for your work.

* The settings for optional equipment will not be stored in the server after
the equipment is disconnected. The settings for optional equipment will be
restored to its defaults each time the client computer logs on to the server.

¢ When printing a large number of bitmap images or using the server in a
WAN environment over dial-up lines such as ISDN, printing may not be
possible or errors may occur, depending on data transfer rates.

¢ When using MetaFrame XP 1.0 or higher versions, we recommend making
settings in [Client Printer bandwidth] under [Citrix Management Console] accord-
ing to the environment.

¢ If a print error occurs on the server and the print job or a printer created in
[Auto-creating client printers] cannot be deleted, we recommend the following:

e MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1
Make settings in [Delete unfinished print jobs] in the registry. For details,
see the Readme file provided with MetaFrame.

e MetaFrame XP 1.0 FR2
Make settings in [Delete pending print jobs at logout] under [Printer Proper-
ties Management] of Citrix Management Console.

MetaFrame's [Printer driver replication]

Using [Printer driver replication] can distribute printer drivers across all servers in
a server farm. We strongly recommend testing this function in your network
environment before using it for your work.

e If the printer drivers are not properly copied, install them directly onto
each server.
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Using DHCP

You can use the printer in a DHCP environment. You can also register the printer
NetBIOS name on a WINS server when it is running.

¢ Printers that register the printer NetBIOS name on a WINS server must be
configured for the WINS server.

* Supported DHCP servers are Microsoft DHCP Server included with Windows
2000 Server, Windows Server 2003, and Windows NT 4.0, and the DHCP server
included with NetWare and UNIX.

¢ If you do not use the WINS server, reserve the printer's IP address in the
DHCP server so the same IP address is assigned every time.

¢ To use the WINS server, change the WINS server setting to “active” using the
control panel.

¢ Using the WINS server, you can configure the host name via the remote network
printer port.

¢ DHCP relay-agent is not supported. If you use DHCP relay-agent on a network
via ISDN, it will result in increased line charges. This is because your computer
connects to the ISDN line whenever a packet is transferred from the printer.

¢ If there is more than one DHCP server, use the same setting for all servers.
The machine operates using data from the DHCP server that responds first.

Using AutoNet

If the printer IPv4 address is not automatically assigned by the DHCP server, a
temporary IP address starting with 169.254 and not used on the network can be
automatically selected by the printer.

& Note
O The IP address assigned by the DHCP server is given priority over that select-
ed by AutoNet.

O You can confirm the current IPv4 address on the configuration page. For
more information about the configuration page, see General Settings Guide.

O When AutoNet is running, the NetBIOS name is not registered on the WINS
server.

O The machine cannot communicate with devices that do not have the AutoNet

function. However, this machine can communicate with Macintosh computers
running Mac OS X 10.2.3. or higher.
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Configuring the WINS Server

The printer can be configured to register its NetBIOS name with a WINS server
when the power is turned on. This enables the NetBIOS name of the printer to be
specified from SmartDeviceMonitor for Admin even in a DHCP environment.
This section explains configuring the WINS server.

& Note

O The WINS server is supported with Windows NT 4.0 Server Service Pack 4 or
higher, and Windows 2000 Servers WINS Manager.

O For details about the WINS server settings, see Windows Help.

O If there is no reply from the WINS server, the NetBIOS name is registered by
broadcast.

O The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

ﬂ Start a Web browser.

g Enter "http://(printer's address)/" in the address bar to access the printer
whose settings you want to change.

Top Page of Web Image Monitor appears.

B Click [Login].
The dialog box for entering the user name and password appears.

ﬂ Enter the user name and password, and then click [Login].
Contact your administrator for information about the settings.

B In the left area, click [Configuration], and then click [Network].
B Click [TCP/IP].

ﬂ Check that [Enable] is selected for [WINS] in the [Ethernet+lEEE 802.11b] column,
and then enter the WINS server IPv4 address in [Primary WINS Server] and
[Secondary WINS Server].

8 Click [Apply].
g Quit Web Image Monitor.

Using telnet

See p.61 “Remote Maintenance by telnet”.



Using the Dynamic DNS Function

Using the Dynamic DNS Function

Dynamic DNS is a function which dynamically updates (registers and deletes)
records (A record and PTR record) managed by the DNS server. When a DNS
server is part of the network environment to which this printer, a DNS client, is
connected, records can be dynamically updated using this function.

Updating

Updating procedure varies depending on whether the printer IP address is static
or acquired by DHCP.

4 Note

O When the dynamic DNS function is not used, records managed by the DNS
server must be updated manually, if the printer's IP address is changed.

O To update the record using the printer, the DNS server has to have one of the
following:

* No security settings made.

* If security settings are made, an IP-specified client (this printer) permits
updating.

« For a static IP setting
If the IP address or host name is changed, the A and PTR records are updated.
If the A record is registered, CNAME is also registered. CNAMEs that can be
registered are as follows:

e Ethernet and IEEE 802.11b
RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)

% For DHCP settings
As a substitute for the printer, the DHCP server updates the record, and one
of the following occurs:

e When the printer acquires the IP address from the DHCP server, the
DHCP server updates the A and PTR records.

¢ When the printer acquires the IP address from the DHCP server, the printer
updates the A record, and the DHCP server updates the PTR record.

If the A record is registered, CNAME is also registered. CNAMEs that can be

registered are as follows:

¢ Ethernet and IEEE 802.11b
RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)

iﬁklmportant

O Dynamic update using message authentication (TSIG, SIG(0)) is not sup-
ported.
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DNS servers targeted for operation

% For static IP setting

e Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

e BIND 8.2.3 or higher

« For DHCP setup, when the printer updates the A record

e Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

e BIND 8.2.3 or higher

% For DHCP setup, when the DHCP server updates records

e Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

e BIND 8.2.3 or higher
* DNS servers with standard NetWare 5 (or a higher version) features

% For IPv6 setting

e Microsoft DNS servers with standard Windows Server 2003 features
e BIND 9.2.3 or higher

DHCP servers targeted for operation

As a substitute for the printer, DHCP servers capable of updating the A record
and PTR record are as follows:

e Microsoft DHCP servers with standard Windows 2000 Server (Service Pack 3
or higher versions)/Windows Server 2003 features

¢ ISC DHCP 3.0 or higher
e DHCP server with standard NetWare 5 features

Setting the dynamic DNS function

Make settings with telnet using the "dns" command. For details, see p.61 “Re-
mote Maintenance by telnet”.



Precautions

Precautions

Please pay attention to the following when using the network interface board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When using NetWare (file server)

If the NetWare file server and printer are on opposite sides of a router, packets
are sent back and forth continuously, possibly incurring communications charg-
es. Because packet transmission is a feature of NetWare, you need to change the
configuration of the router. If the network you are using does not allow you to
configure the router, configure the machine instead.

% Configuring the router
Filter packets so they do not pass over the dial-up router.

& Note

O The MAC address of the filtering printer is printed on the printer configu-
ration page. For more information about printing a configuration page, see
Printer Reference.

O For more information about configuring the printer if the router cannot be
configured, see the following instructions.

Configuring the printer with NetWare

ﬂ Following the setup method described earlier in this manual, configure the
file server.

ﬂ Set the frame type for NetWare environment.

p Reference

For more information about selecting a frame type, see the General Settings
Guide.

Configuring the printer without NetWare

ﬂ When not printing, the network interface board sends packets over the net-
work. Set NetWare to “inactive”.

A Reference
For more information about selecting a protocol, see General Settings Guide.
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When Using Network Utility

If the machine is connected to a network, observe the following points when set-
ting up the machine or changing settings:

For more details, see the operating instructions and Help for ScanRouter V2 Pro-
fessional and DeskTopBinder Lite/Professional.

2
*»*

R
**

When a dial-up router is connected in a network environment

The settings for the delivery server to be connected must be made appropri-
ately for the machine with ScanRouter V2 Professional, Auto Document Link,
or DeskTopBinder Lite/Professional. In addition, set up connected devices
using the I/O settings of ScanRouter V2 Administration Utility.

If the network environment changes, make the necessary changes for the de-
livery server using the machine, the administration utility of client comput-
ers, Auto Document Link, and DeskTopBinder Lite/Professional. Also, set
the correct information for the connected devices using the I/O settings of
ScanRouter V2 Administration Utility.

iﬁklmportant

O If the machine is set up to connect to the delivery server via a dial-up router,
the router will dial and go online whenever a connection to the delivery
server is made. Telephone charges may be incurred.

When connected to a computer that uses dial-up access

* Do not install ScanRouter V2 Professional on a computer which uses dial-up
access.

¢ When using ScanRouter V2 Professional, DeskTopBinder Lite /Profession-
al, Auto Document Link, or a TWAIN driver on a computer with dial-up
access, a dial-up connection may be performed when connecting to the de-
livery server and other equipment, depending on the setup. If the compu-
ter is set up to connect to the Internet automatically, the confirmation
dialog box will not appear, and telephone charges may be incurred with-
out your being aware of it. To prevent unnecessary connections, the com-
puter should be set up so the confirmation dialog box always appears
before establishing a connection. Do not make unnecessary connections
when using the above listed software.



Precautions

NetWare Printing

Form feed

You should not configure form feed on NetWare. Form feed is controlled by the
printer driver on Windows. If NetWare form feed is configured, the printer
might not work properly. If you want to change form feed settings, always con-
figure them using Windows.

e Under Windows 95/98 /Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the printer properties dialog box.

e Under Windows 2000/ XP and Windows Server 2003, clear the [Form feed]
check box on the [NetWare Settings] tab in the printer properties dialog box.

e Under Windows NT 4.0, clear the [Form feed] check box on the [NetWare Set-
tings] tab in the printer properties dialog box.

Banner page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it using Windows.

¢ Under Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the printer properties dialog box.

e Under Windows 2000/ XP and Windows Server 2003, clear the [Enable banner]
check box on the [NetWare Settings] tab in the printer properties dialog box.

e Under Windows NT 4.0, clear the [Enable banner] check box on the [NetWare
Settings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be
cut off for about 30-40 seconds before re-connecting. Depending on the NetWare
specification, print jobs may be accepted, but they will not be printed during this
interval.

When using the machine as a remote printer, wait about two minutes after reset-
ting before attempting to print.
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When the optional IEEE 802.11b interface unit Is Installed

When using the wireless LAN interface on the network, note the following;:

% When moving the machine
Detach the antennas when relocating the machine locally.
After moving the machine, reattach the antennas, ensuring that:

¢ The antennas are positioned clear of obstacles.

¢ There is 40 to 60 mm between the antennas, so that they do not touch.

+ If the network area provides poor radio environment
Where radio wave conditions are bad, the network may not function due to
interrupted or failed connections. When checking the wireless LAN signal
and the access point, follow the procedure below to improve the situation:

* Position the access point nearer to the machine.

* C(lear the space between access point and machine of obstructions.

* Move radio wave generating appliances, such as microwaves, away from
the machine and access point.

4 Note

O For information about how to check radio wave status, see the General Settings
Guide.

O For more information about access point radio wave conditions, refer to the
access point manual.



Information about Installed Applications

Information about Installed Applications

RSA® BSAFE

™

RSA i

SECURED

e This product includes RSA® BSAFE cryptographic or security protocol soft-
ware from RSA Security Inc.

* RSA is a registered trademark and BSAFE is a registered trademark of RSA
Security Inc. in the United States and/or other countries.

* RSA Security Inc. All rights reserved.
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Specifications

Interface

1000BASE-T, 100BASE-TX, 10BASE-T, IEEE 802.11b

Frame type

Ethernetll, IEEE 802.2, IEEE 802.3, SNAP

Printer

IPv4
LPR
RSH
RCP
DIPRINT
FTP
IPP
IPX/SPX (NetWare)
AppleTalk
SMB

Network Scanner

IPv4
RSH
FTP
SMTP

POP3

SMB

NCP

Document Server

IPv4
FTP
HTTP

Management Function

1Pv4
RSH
RCP
FTP
SNMP
HTTP

TELNET (mshell)
NBT
DHCP
DNS
LDAP

SNMP v1/v2

MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB

SNMP v3

MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB, SNMP-
FRAMEWORK-MIB, SNMP-TARGET-MIB, SNMP-NOTIFICATION-
MIB, SNMP-USER-BASED-SM-MIB, SNMP-VIEW-BASED-ACM-MIB

To use IPP and SMB, use the SmartDeviceMonitor for Client port.

To use IPP under Windows XP, Windows Server 2003, use the Standard IPP port.
To use IPP under Windows 98, Windows 2000, Windows NT, use SmartDevice-

Monitor for Client.




Specifications

Functions

The following functions are available with the machine:
e Copy

¢ Printer

e Scanner

* Document Server

& Note

O The machine must be equipped with the Printer /Scanner Unit in order to use
the printer or scanner function.
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specifications, 130

spoolsw, 85

status, 86
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